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Communications regulation information
FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.
You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)
If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.
IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,

could void the FCC Certification and negate your authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.
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vii

DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus set out in the radio interference regulations of the
Canadian Department of Communications.
Observation des normes—Classe B Le présent appareil numérique n’émet pas de bruits
radioélectriques dépassant les limites applicables aux appareils numériques de la Classe B
prescrites dans les règlements sur le brouillage radioélectrique édictés par le Ministère des
Communications du Canada.

VCCI statement

CD-ROM drive
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous exposure.
WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an authorized Apple service provider.

If you have an internal Apple CD-ROM drive in your computer, your computer is a Class 1
laser product. The Class 1 label, located on the computer, indicates that the drive meets
minimum safety requirements.

Class 1 label

viii
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Welcome to Power Macintosh

Congratulations on the purchase of your new Macintosh. Your computer is
designed to give you the highest performance combined with real ease of
use—it’s easy to set up, easy to use, and easy to expand. This manual will
guide you through the setup procedure, tell you how to expand your
Macintosh, and provide many tips on using your new system.
Your Macintosh is powered by the new
microprocessor (or “chip”).
This microprocessor was designed by Apple Computer, Inc., Motorola, Inc.,
and IBM Corporation. The
microprocessor uses Reduced
Instruction Set (RISC) technology to deliver very high performance at the
lowest possible cost. The
RISC microprocessor represents the state
of the art in microprocessor design.
Your new Macintosh will run almost all your existing Macintosh software,
but for best performance and greatest speed, look for the new software
programs designed especially for Power Macintosh computers. You’ll find
Power Macintosh programs at any software store that carries products for
Macintosh.
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Setting Up Your Computer and
Learning the Basics
Chapter 1

Setting Up

Chapter 2

Safety and Health Information

Chapter 3

Learning to Use Your Computer

Chatper 4

Basic Skills

Part I of this book provides the information you need
to set up and learn about your Macintosh. It includes
instructions for
m Setting up the computer and turning it on
m Using the computer safely
m Learning basic Macintosh skills
If you are new to the Macintosh, go through all
the chapters in this section. You’ll find a tutorial
in Chapter 3 that will acquaint you with
Macintosh skills.
If you’re an experienced Macintosh user, go through
the setup instructions in Chapter 1 and read the
health and safety information in Chapter 2, then
proceed to Part II, “More About Your Macintosh.”

I

part

Follow the instructions in this
section to set up your computer

1

Setting Up
Setting up your computer involves these steps:
m Plugging in the computer
m Connecting a
monitor
m Connecting the
mouse and
keyboard
m Turning the
computer on
Macintosh computer

Monitor

Keyboard

Mouse

Adapters for composite video
Keyboard cable
(Power Macintosh 8100/80AV only)

Monitor cable
(sometimes built into the monitor)

Monitor power cord
(sometimes built into the monitor)

Computer power cord
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Plugging in the computer
Before you plug your Macintosh into a wall socket, carefully read all the
installation instructions in Chapter 1. Then, before you connect anything to
your Macintosh, follow the instructions below to plug it in. The plug grounds
and protects the computer from electrical damage while you are setting up.
When you are ready to begin:
1

Plug the socket end of the computer’s power cord into the recessed power plug (marked
with the symbol ≤) on the back of the computer.

2

Plug the other end of the power cord into a three-hole grounded outlet or power strip.

Choose a power outlet to which you have easy access.
WARNING This equipment is intended to be electrically grounded. Your

Macintosh is equipped with a three-wire grounding plug—a plug that
has a third (grounding) pin. This plug will fit only a grounded AC
outlet. This is a safety feature. If you are unable to insert the plug into
the outlet, contact a licensed electrician to replace the outlet with a
properly grounded outlet. Do not defeat the purpose of the grounding
plug!

2

Chapter 1

Power cord socket

Power cord plug

IMPORTANT Be sure at least one end of the power cord is within easy reach so

that you can unplug the computer when you need to.
If the computer starts up: If you hear a tone, the computer has started up and
you need to turn it off before proceeding. The power switch is located on the
back of the computer and is marked with the symbol I. Press the switch to
turn the computer off.

Installing an expansion card
If you purchased any expansion cards for your Macintosh, install them now
(see “Installing an Expansion Card” in Chapter 5 for instructions). If you
don’t have an expansion card, go on to the next section, “Connecting a
Monitor.”

Setting Up
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Connecting a monitor
You can connect many types of monitors to your Macintosh, including:
m Apple AudioVision monitors. AudioVision monitors include built-in
speakers, a microphone, video, and an ADB port (for an input device such
as a keyboard).
m Most standard monitors. See the Technical Information booklet that came
with your computer for a complete list.
This section contains instructions for connecting both types of monitors. To
connect a monitor from a manufacturer other than Apple, also refer to the
instructions that came with the monitor.

Connecting the monitor’s power cord
Monitors have two cords to connect: a power cord and a monitor cable. To
connect the monitor power cord:
1

Place the monitor where you will be using it.

Keep in mind these considerations:
m Allow a few inches for air circulation around the computer and monitor.
m Make sure the top of the screen is slightly below eye level when you’re
sitting at the keyboard.
m Position the monitor to minimize glare and reflections on the screen from
overhead lights and windows.
m Consult “Arranging Your Office” in Chapter 2 for suggestions about
locating your computer equipment.
2

Connect the monitor’s power cord to the monitor.

On some monitors, the cord is already attached.

4

Chapter 1

3

Plug in the monitor’s power cord.

Some power cords are designed to plug into the back of your computer. You
can also plug the power cord into a grounded electrical outlet (an adapter may
be needed).
Some monitors have to be connected to a grounded power outlet, not to the
computer’s power socket. Check the information that came with the monitor.

Monitor power cord

Monitor power socket

Setting Up
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Connecting the monitor cable
After you plug in the monitor’s power cord, you connect the monitor cable to
the computer’s monitor port. Your computer has two monitor ports: a standard
monitor port, and a high-density monitor port for AudioVision monitors. The
high-density port accepts a monitor with a screen 16 inches or smaller
(measured diagonally).

High-density monitor port
(for connecting an
AudioVision monitor)

Second monitor port
(for connecting a
standard monitor)

You can connect one or two monitors of either type, or one of each type.
To connect the monitor cable:
1

Attach the monitor cable to the monitor.

On some monitors, the cable is already attached.

6

Chapter 1

2

Attach the monitor cable to one of the monitor ports on the back panel of the computer.

If the monitor is an AudioVision model, such as the Apple AudioVision 14,
attach the monitor cable to the computer’s high density monitor port. If the
monitor is a standard model, attach the monitor cable to the standard monitor
port.

AudioVision monitors
are connected here.

Standard monitors
are connected here.

If you have an AudioVision monitor, see the information that came with the
monitor to use its special features.

Setting Up
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Connecting the mouse and keyboard
You have a choice of several keyboards for your Macintosh. They are all
connected the same way.
1

Plug the mouse cable into the port on either side of the keyboard.

Most right-handed people prefer to use the mouse with their right hand; most
left-handed people prefer to use their left hand. Plug the mouse into the port
on the side you prefer.
The plug and the port are marked with the same icon (◊). Align the icons
before you insert the plug. The positions of the port and icon on your
keyboard may be different from those pictured.
ADB icon

By the way: The ◊ icon is called the Apple Desktop Bus (ADB) icon.
2

Plug the keyboard cable (both ends are the same) into the other port on the keyboard.

3

Plug the keyboard cable into the port on the back of the computer marked with the
◊ icon.

Some monitors have a port to which you can connect the keyboard or mouse.
See the information that came with your monitor.
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Chapter 1

Connecting other devices
If you are new to the Macintosh: It’s a good idea to get some experience with
your computer before connecting other devices, such as a printer or scanner.
Go through the rest of the material in Part I, including the learning materials
in Chapter 3.
When you are ready to connect other devices to your Macintosh, follow the
instructions in Chapter 5.

Turning the computer on
To turn on the computer for the first time, follow these steps.
1

Turn on the monitor.

See the information that came with your monitor for the location of the power
switch. On Apple monitors, the power switch has this icon: I.
By the way: You only need to turn on the monitor once. From now on, the
monitor will turn off automatically when you shut down the computer, and it
will turn on automatically when you start up the computer. (If the monitor is
not plugged into the computer, it must be turned on separately each time you
turn on the computer.)

Setting Up
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2

Turn on your computer by pressing the Power On key.

You’ll find the Power On key at the top of the keyboard. You can recognize
this key by the triangle outline on it.

10

Chapter 1

3

Check to see what’s on your screen.

m If you see the Macintosh desktop, shown here, your system software is
already set up correctly. Skip now to “What’s Next?”

Hard disk icon

Macintosh desktop

m If you see a blinking question mark, you need to install system software on
the computer’s hard disk. (System software is a set of programs the
computer uses to start itself up.)

See “Reinstalling System Software” in Chapter 10 of this book for
information on installing system software.
m If you see anything else on your screen, or if you see nothing at all, see the
next section, “Problems Turning on Your Computer?”
IMPORTANT If you need to turn off your computer at any point, please see

“Turning the Computer Off” at the end of Chapter 3. It is very important to
use the correct procedure for shutting down your Macintosh before turning it
off.

Setting Up
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Problems turning on your computer?
If you don’t see anything on the screen, check these items to see if you can
identify the problem.
m Is the computer plugged into a power source? If it is plugged into a power
strip, is the power strip turned on?
m Is the computer turned on? The power-on light on the front panel should
be on.
m Are the keyboard and mouse cables connected correctly? (Don’t disconnect
the keyboard or mouse cables while your computer is on. You could
damage your equipment.)
m Is the monitor power cord plugged in?
m Is the monitor turned on? (Check the power-on light on the front of the
monitor.)
m Is the monitor’s cable attached firmly to both the monitor and computer?
m Is the brightness control on the monitor adjusted correctly? (On Apple
monitors, the brightness control is marked with the symbol ¤.)
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What’s next?
You’ve completed setting up your computer. Next, be sure to read Chapter 2,
“Safety and Health Information,” which contains important tips on working
safely and comfortably with your computer.
Then continue with one of the following steps:
m If you are new to the Macintosh, turn to Chapter 3, “Learning to Use Your
Computer.”
m If you are an experienced Macintosh user, turn to Part II, “More About
Your Macintosh.”
m If you want to install application software on your computer, refer to
Chapter 6 of this book and to the Macintosh Reference for information on
setting up your programs and managing memory. You’ll need this
information to properly set up any software programs specifically designed
for Power Macintosh computers.
If you have questions about your computer that are not covered in this book,
consult the Macintosh Reference.

Setting Up
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Read this section to learn how to
use your computer safely
and comfortably

2

Safety and Health Information

Safety instructions
For your own safety and that of your equipment, always take the following
precautions.
Turn off the computer completely and disconnect the power plug (by pulling
the plug, not the cord) if any of the following conditions exists:
m The power cord or plug becomes frayed or otherwise damaged.
m You spill something into the case.
m Your Macintosh is exposed to rain or any other excess moisture.
m Your Macintosh has been dropped or the case has otherwise been
damaged.
m You suspect that your Macintosh needs service or repair.
m You want to clean the case (use only the recommended procedure
described below).
For additional safety:
m If you ever need to remove the cover of your computer, replace it before
you use the computer.
m Never turn on your computer with any of the internal parts removed.
m Never turn on your computer with any parts of the external closure
removed.

15

Be sure that you always do the following:
m Keep your Macintosh away from sources of liquids, such as wash basins,
bathtubs, shower stalls, and so on.
m Protect your Macintosh from dampness or wet weather, such as rain, snow,
and so on.
m Read all the installation instructions carefully before you plug your
Macintosh into a wall socket.
m Keep these instructions handy for reference by you and others.
m Follow all instructions and warnings dealing with your system.
WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.

To clean the case, do the following:
1

Turn off the computer and then disconnect the power plug. (Pull the plug, not the cord.)

2

Wipe the surfaces lightly with a clean, soft cloth dampened with water.
WARNING If you have a problem with your computer and nothing in the

manuals that came with the computer solves the problem, consult the
service and support information that came with your computer for
information on how to contact an Apple-authorized service provider or
Apple for assistance.
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Health-related information about computer use
Muscle soreness, eye fatigue, and other discomforts and injuries sometimes
associated with using computers can occur from performing any number of
activities. In fact, misuse of the same muscles during multiple activities can
create a problem that might not otherwise exist. For example, if you engage in
nonwork activities that involve repetitive stress on the wrist—such as
bicycling—and also use your computer keyboard improperly, you may
increase your likelihood of developing wrist problems. Some individuals are
at greater risk of developing these problems because of their health,
physiology, lifestyle, and general exposure to stress. Work organization and
conditions, such as workstation setup and lighting, also play a part in your
overall health and comfort. Preventing health problems is a multifaceted task
that requires careful attention to the way you use your body every hour of
every day.
The most common health effects associated with using a computer are
musculoskeletal discomfort and eye fatigue. We’ll discuss each area of
concern below. For information about electric and magnetic emissions, look
in the reference material that came with your computer.

Musculoskeletal discomfort
As with any activity that involves sitting for long periods of time, using a
computer can make your muscles sore and stiff. To minimize these effects, set
up your work environment carefully, using the guidelines that follow, and take
frequent breaks to rest tired muscles. To make working with your computer
more comfortable, allow enough space in your work area so that you can
change position frequently and maintain a relaxed posture.
Another type of musculoskeletal concern is repetitive stress injuries (RSIs),
also known as cumulative trauma disorders (CTDs). These problems can
occur when a certain muscle or tendon is repeatedly overused and forced into
an unnatural position. The exact causes of RSIs are not totally understood, but
in addition to awkward posture, such factors as the amount of repetition, the
force used in the activity, the individual’s physiology, workplace stress level,
and lifestyle may affect the likelihood of experiencing an RSI.

Safety and Health Information

17

RSIs did not suddenly arise when computers were invented; tennis elbow and
writer’s cramp, for example, are two RSIs that have been with us for a long
time. Although less common than other RSIs, one serious RSI discussed more
often today is a wrist problem called carpal tunnel syndrome, which may be
aggravated by improper use of computer keyboards. This nerve disorder
results from excessive pressure on the median nerve as it passes through the
wrist to the hand.
This section offers advice on setting up your work area to enhance your
comfort while you use your computer. Since the effects of repetitive
movements associated with using a computer can be compounded by those of
other work and leisure activities to produce or aggravate physical problems,
proper use of your computer system must be considered as just one element
of a healthy lifestyle.
No one, of course, can guarantee that you won’t have problems even when you
follow the most expert advice on using computer equipment. You should
always check with a qualified health specialist if muscle, joint, or eye
problems occur.

Eye fatigue
Eye fatigue can occur whenever the eyes are focused on a nearby object for a
long time. This problem occurs because the eye muscles must work harder to
view an object that’s closer than about 20 feet (6 meters). Improper lighting
can hasten the development of eye fatigue. Although eye fatigue is annoying,
there’s no evidence that it leads to permanent damage.
Whenever you’re engaged in an activity that involves close-up work—such as
reading a magazine, doing craft work, or using a computer—be sure to have
sufficient glare-free lighting and give your eyes frequent rest breaks by
looking up and focusing on distant objects. Remember to have your eyes
examined regularly.
To prevent discomfort and eye fatigue:
m Arrange your work space so that the furniture is properly adjusted for you
and doesn’t contribute to an awkward working posture.
m Take frequent short breaks to give your muscles and eyes a chance to rest.
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Arranging your office
Here are some guidelines for adjusting the furniture in your office to
accommodate your physical size and shape.
m An adjustable chair that provides firm, comfortable support is best. Adjust
the height of the chair so your thighs are horizontal and your feet flat on
the floor.
The back of the chair should support your lower back (lumbar region).
Follow the manufacturer’s instructions for adjusting the backrest to fit your
body properly.
m When you use the computer keyboard, your shoulders should be relaxed.
Your upper arm and forearm should form an approximate right angle, with
your wrist and hand in roughly a straight line.
45–70 cm (18–28 in.)

Shoulders relaxed
Forearms and hands
in a straight line
Forearms level
or tilted up slightly
Lower back supported

Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
monitor by placing something
under it or by raising your
work surface.)
Screen positioned to avoid
reflected glare
Clearance under work surface

Thighs horizontal
Feet flat on the floor

Safety and Health Information
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You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your feet flat
on the floor, you can use a footrest with adjustable height and tilt to make up
for any gap between the floor and your feet. Or you may lower the desktop to
eliminate the need for a footrest. Another option is to use a desk with a
keyboard tray that’s lower than the regular work surface.
m Position the mouse at the same height as your keyboard. Allow adequate
space to use the mouse comfortably.
m Arrange the monitor so the top of the screen is slightly below your eye
level when you’re sitting at the keyboard. The best distance from your eyes
to the screen is up to you, although most people seem to prefer 18 to 28
inches (45 to 70 cm).
m Position the monitor to minimize glare and reflections on the screen from
overhead lights and windows. You may want to use a tiltable monitor
stand. The stand lets you set the monitor at the best angle for viewing,
helping to reduce or eliminate glare from lighting sources you can’t move.

Avoiding fatigue
m Change your seated position, stand up, or stretch whenever you start to feel
tired. Frequent short breaks are helpful in reducing fatigue.
m Use a light touch when typing or using a mouse and keep your hands and
fingers relaxed.
m Some computer users may develop discomfort in their hands, wrists, or
arms after intensive work without breaks. If you begin to develop chronic
pain or discomfort in your hands, wrists, or arms, consult a qualified
health specialist.
m Allow adequate workspace so that you can use your keyboard and mouse
comfortably. Place papers or other items so you can view them easily while
using your computer. A document stand may make reading papers more
comfortable.
m Eye muscles must work harder to focus on nearby objects. Occasionally
focus your eyes on a distant object, and blink often while you work.
m Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.

20
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What’s next?
You’ve completed setting up your computer. Continue with one of the
following steps:
m If you are new to the Macintosh, continue with Chapter 3, “Learning to
Use Your Computer.”
m If you are an experienced Macintosh user, turn to Part II, “More About
Your Macintosh.”
m If you want to install application software on your computer, refer to
Chapter 6 of this book and the Macintosh Reference for information on
setting up your programs and managing memory. You’ll need this
information to properly set up any software programs specifically designed
for Power Macintosh computers.
If you have questions that are not covered in this book, consult the Macintosh
Reference.

Safety and Health Information
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Go through the exercises in this
chapter to learn how to
use your computer

3

Learning to Use Your Computer

Your computer comes with a tutorial that teaches you the basics. The tutorial
is divided into two parts:
m Part 1 You start the Macintosh Basics tour on your computer, which presents
the basic skills you need to master.
m Part 2 After you complete the Macintosh Basics tour, you return to this
chapter to practice what you learned. You also learn some additional skills.
If you’ve never used a Macintosh computer before, you should complete both
parts of the tutorial.
If you are an experienced Macintosh user, you may want to look over the rest
of this book to learn about special features of this computer. Then, as you
work with your Macintosh, consult the Macintosh Reference for answers to
questions about the system software that came with your computer.
IMPORTANT If you need to turn off your computer at any point before

finishing the tutorial, please see “Turning the Computer Off” at the end of
this chapter.
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Part 1 Starting the Macintosh Basics tour
Your Macintosh Basics tour is on the hard disk that’s inside your computer. To
take the tour, follow these steps:
Make sure your computer is turned on. If the screen is dark, try adjusting the
screen (see “Problems Turning On Your Computer?” in Chapter 1) until you
see words and small pictures on your screen.
1

Use your hand to scoot the mouse along the table.

Hold the mouse as shown, cable pointing away from you. Slide it so that it
stays in contact with the table. Don’t press the mouse button. Watch the arrow
on your screen to see if it moves when you move the mouse.

2

Notice that the arrow (8) moves in the direction you move the mouse.

If the arrow doesn’t move on the screen, make sure that the cable connecting
the mouse to the keyboard is secure and that your mouse is positioned as
shown in the picture. (Don’t disconnect the cable while your computer is on;
you could damage your equipment.)
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3

Move the mouse so that the tip of the arrow (8) is on the picture labeled “Macintosh HD.”

Make sure the tip of the arrow is on the picture, not the words
“Macintosh HD.”

Move the arrow so that it
is on top of this picture.

4

Being careful not to move the mouse, press the button twice in quick succession. (This
is called “double-clicking.”)

Now your screen should look like the picture following step 5. The items in
the illustration below may not exactly match those on your screen. The only
item you need right now is the Macintosh Basics folder.
If the screen doesn’t look right, try steps 1 and 2 again, paying special
attention to the following:
m Make sure the tip of the arrow is touching the picture, not the words
beneath it.
m Be sure to press the mouse button twice.
m Press twice quickly and be careful not to move the mouse while you press.
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5

Move the mouse to place the tip of the arrow (8) on the picture of the folder labeled
“Macintosh Basics.”

Move the arrow
so that it is on
top of this picture.

6

Being careful not to move the mouse, press the button twice in quick succession.

Now your screen should look like the following illustration:
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7

Move the mouse so that the arrow is on the picture of the man labeled “Macintosh
Basics.”

Move the arrow so that it
is on top of this picture.

8

Press the mouse button twice in quick succession.

Now your screen should look like the following picture:

If you don’t see this screen, try again, paying special attention to the
following:
m Make sure the tip of the arrow is touching the picture, not the words
beneath it.
m Be sure to press the mouse button twice.
m Press twice quickly and be careful not to move the mouse while you press.
9

Follow the instructions on the screen and work through the tour.

When you finish the tour, continue with the rest of this chapter.
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Part 2 Practicing your new skills
You should now have completed the Macintosh Basics tour.
The second part of your training gives you an opportunity to think about
what you’ve learned so far and to practice your new skills.

Reviewing what you’ve learned
Before continuing, take a few moments to answer these questions. They will
help you summarize the information you learned in Macintosh Basics. You
may want to write (or circle) your answers as appropriate. The correct
answers are in the next section of this chapter.
If you have any trouble answering the questions, look in Chapter 4, “Basic
Skills.”
Question: What is the name of the area where you do all your work? (It’s shown

below.)
Answer:____________________________________________
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Question: What are pictures on the Macintosh desktop called? Two examples are

shown below.
Answer:____________________________________________

What is the name for these
pictures on the Macintosh
desktop?

Circle the hard disk window in the illustration below.
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Circle the hard disk icon in the illustration below.

Question: Circle the active window on the desktop below. How do you make a

window active?
Answer:____________________________________________
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Question: Which menu is the Save command in?
Answer:____________________________________________
Question: How do you throw an item away?
Answer:____________________________________________
Label the parts of this window.
A.
B.
C.
D.
E.
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Answers to the review questions
These are the answers to the review questions that you completed earlier.
Question: What is the area called where you do all your work? (It’s shown below.)
Answer: the desktop
Question: What are pictures called on the Macintosh desktop?
Answer: icons
Circle the hard disk window in the illustration below.

Circle the hard disk icon in the illustration below.
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Question: Circle the active window shown on the desktop below. How do you make

a window active?
Answer: by clicking anywhere inside of it

Question: Which menu is the Save command in?
Answer: the File menu
Question: How do you throw an item away?
Answer: by dragging it to the Trash
Label the parts of this window.
A. The close box
B. The title bar
C. A scroll arrow
D. The scroll bar
E. The size box

Learning to Use Your Computer

33

Practice session
Now you can practice what you learned in Macintosh Basics. You’ll be
practicing your skills using real programs that came with your computer,
rather than the sample ones in Macintosh Basics.
IMPORTANT If you get lost at any point during the practice session, or if
something unexpected happens, please turn to “Clues on Your Screen” in this
chapter. These tips will help you get back on track.

1: Creating a new document
1

Open the hard disk icon and then open the SimpleText program, as shown below.

1 Double-click the hard disk
icon to open it.
2 If a window with the name
of your hard disk doesn’t
appear, click the disk icon
again twice.
3 To open the SimpleText
program, double-click the
SimpleText icon.

When the SimpleText program
opens, a window appears with
“Untitled” in the title bar. This is
your blank document.
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2

Use the keyboard to type a few lines of text into the blank document.

Type text in the blank document.

It doesn’t matter what you type. If you make an error, press the Delete key to
backspace over the incorrect letters, then retype them.
3

Open the File menu and choose the Save command to save your new document.

When you save a document, you are storing it on the hard disk. You need to
save every document you create. If you don’t save it, the document is lost
when you turn off the computer.

Choose Save from
the File menu.

A box like the one in the next step appears, with the word “Untitled” near the
bottom. This box lets you name and save your document.

Learning to Use Your Computer

35

4

Don’t click anywhere. Just type the name “Practice File.” Then click the button labeled
Save.

Type the name of
your document to
replace “Untitled.”

The name you type should replace the word “Untitled” in the box. If it
doesn’t, place the pointer to the left of the U in “Untitled,” then press the
mouse button and drag across the word. When “Untitled” is highlighted (the
text is surrounded with a black box), type the new name.

Click Save to save your
Practice File on the hard disk.

After you click Save, a copy of your document is stored on the hard disk in
your computer. The new name appears in the title bar of the document.
The name of your document
appears in the title bar.
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5

Open the File menu and choose Quit to quit the SimpleText program.

Choose Quit from the File
menu to quit your program.

The SimpleText program closes, along with your document.
6

Check for the file you saved in the hard disk window.

You should see the icon for the document you saved in the hard disk window.
If your Practice File icon doesn’t appear, it may be in a hidden part of the
window. You can scroll through the window to find the icon if you need to.

Here’s the new file
you just created.

If you don’t see your document,
click the arrows to scroll through
the window.

That’s the end of the first exercise. You may want to take a break before you
continue.
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2: Storing your work inside a folder
You can organize your work on the Macintosh by creating folders and storing
your documents inside of them.
1

Open the File menu and choose New Folder.

A folder icon named “untitled folder” appears in the active window on the
desktop.

A new folder icon appears
in the hard disk window.

2

Without clicking anywhere, type “My Work” to name the folder.

Notice that the words “untitled folder” are highlighted and boxed. That means
the name you type will replace these words.

The new name of your
folder appears here.
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3

Drag the Practice File into the folder named “My Work.”

Move the pointer to the Practice File. Then press and hold down the button
while you move the Practice File to the folder named “My Work.” When the
tip of the pointer is on the folder icon and the folder becomes highlighted,
release the button.

Move the pointer to this icon. Then press
and hold down the button while you move
this icon to the folder named “My Work.”

4

Open the folder named “My Work.”

You open a folder the same way you open any icon: double-click it, or click it
and choose Open from the File menu.
The “My Work” folder window opens, and you can see your Practice File.

You have now completed the second practice session. You may want to take a
break before continuing.
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3: Throwing an item away
As you work, you will want to remove items you no longer need from the
hard disk. You remove items by throwing them into the Trash. In this exercise,
you will throw the Practice File into the Trash.
1

If the Macintosh HD window is not already open, open it by double-clicking the
Macintosh HD icon.

2

If the folder named “My Work” is not already open, open it.

Note: If you can’t see the Trash icon (which should be in the lower-right
corner of your screen) move the windows so that the Trash icon is visible. To
move a window, place the pointer in the window’s title bar (the stripes at the
top of the window), and drag the window.
3

Drag the Practice File to the Trash icon.

Place the pointer on the Practice
File icon. Press and hold down
the button as you move the
pointer to the Trash icon.
When the tip of the pointer is on
the Trash icon and the Trash
icon becomes highlighted,
release the button.

When you place an icon in the Trash, it is not immediately removed from
your disk. The Trash icon bulges to show you that the Practice File is in the
Trash, but still on your disk.
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4

Open the Trash icon (by double-clicking it) to see your Practice File there.

Your Practice File is
still in the Trash.

5

Open the Special menu and choose Empty Trash.

A dialog box appears. The computer displays a dialog box when it asks you to
confirm an action. You must click OK or another button in the dialog box
before you can take any other action.
6

Click OK.

The Trash is emptied and the Trash icon returns to normal.
The Empty Trash command permanently removes from your disk anything
that is in the Trash. Always be sure that you know what you’re removing
before you choose Empty Trash.
Note: You can get an item back from the Trash by moving its icon back to
your disk before you choose Empty Trash from the Special menu. After you
choose Empty Trash, you can’t recover items you’ve thrown away.
You have completed all of the practice exercises. Before you continue with
your own work, you might want to skim Chapter 4, “Basic Skills,” for a
summary of basic skills that you’ll need as you work.
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What’s next?
The best way to get experience working with your computer is to begin to do
your own work. You may have already purchased application programs to
work with. You’ll need to install these on your hard disk. Be sure to read the
manuals that came with your application programs for information on how to
install them. (To install your programs, you’ll need to know how to insert a
floppy disk into your computer. See Chapter 4, “Basic Skills,” for
instructions.)

Clues on your screen
As you work, check the screen frequently for these important clues about
where you are. If you are lost or if something unexpected happens, ask your
self these questions:

Is this the right program?
Check the menu bar. If it looks like this example, you are in the Finder. If any
of these menu names are different or missing, you are inside another program.
To get back to the Finder, click anywhere on the desktop pattern.
The Finder menu bar
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Is the icon or text you want to work with selected?
Commands you choose in menus usually work only if an icon or some text is
selected. Check the item you want to work with to make sure it’s highlighted
(which means it’s selected).

Is it best to start over?
If you get stuck or lost as you practice on the computer, try one or more of
the following remedies and then start the practice session over again:
m If an unwanted or confusing window is on your screen, click the Close box
in the upper-left corner of the window to close it.
m If an unwanted window or box contains a Cancel button, click it.
m If the File menu contains the word Quit, choose it.
m If you’re really stuck, restart your computer.
To restart, click the desktop (the background pattern on your screen), and
then choose Restart from the Special menu. This turns the computer off
and then back on. When you restart a computer, problems often clear up.

Turning the computer off
If you plan to continue learning about your Macintosh or if you plan to
continue working, don’t turn off your computer yet. When you are ready to
stop working, follow the steps on the next page.
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1

Use the mouse to choose the Shut Down command from the Special menu.

Choosing Shut Down readies the hard disk for a fast restart next time you turn
on the computer. It also prompts you to save any unsaved work on a disk
before turning the power off.

To turn on the computer again, just press the Power On key on the keyboard.
WARNING Do not turn the computer off by pressing the power switch on

the back panel. If you do so, you will lose any work you haven’t
previously saved onto a disk. You also risk losing open documents.

IMPORTANT Be sure to shut down the computer if you need to do any of the

following:
m Move the computer
m Attach other equipment to the computer
m Unplug the computer
m Leave the computer for an extended period of time
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Refer to this chapter for information
on basic Macintosh skills

4

Basic Skills

This section provides information on the following basic skills:
m Working with icons
m Working with windows
m Working with documents
m Working with disks
m Organizing your desktop
m Working with menus
m Keyboard shortcuts in the Finder and in directory dialog boxes
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Working with icons
An icon is a picture that represents something else.
This icon represents
the hard disk.
These icons
represent folders,
programs, and
documents that
are stored on the
hard disk.

This icon represents
the Trash.

Selecting icons
To do this

Follow these steps

Select the icon

Click the item.

Deselect an icon

Click anywhere except the selected icon.

Select multiple icons

While holding down the Shift key, click each icon.

Deselect an icon in a
group of selected icons

While holding down the Shift key, click the icon.

Select multiple icons
1. Place the pointer at one corner of the group of icons.
that are near each other 2. Drag diagonally to select the icons, then release the
button.
Select a list or partial
list of icons
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1. Place the pointer to the left of the top icon or the bottom icon.
2. Drag up or down the list, releasing the button when the
items are selected.

Copying icons
To do this

Follow these steps

Copy an icon onto
another disk

Drag the icon to the icon of the other disk
or to an icon or window that belongs to that disk.

Copy an icon
on the same disk

1. Click the icon to select it.
2. Choose Duplicate from the File menu, or press x-D.
3. If you wish, rename the new icon and drag it to a new location.
You can also make a copy by holding down the Option key
while you drag the icon to another folder or window.

Opening icons
To do this

Follow these steps

Open an icon
(disk, folder, etc.)

1. Click the icon.
2. Choose the Open command from the File menu.
Or double-click (click twice quickly) on the icon.

Moving icons
To do this

Follow these steps

Move an icon
on a disk

Drag the item to the location you want.

Naming icons
To do this

Follow these steps

Select text in an
icon’s name

Click the icon name (not the icon itself).

Rename an icon

1. Select the text under the icon.
2. Type the new name.
3. Press the Return key.
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Removing items from the disk and retrieving them from the Trash
To do this

Follow these steps

Erase or remove
an item from a disk

1. Drag the icon to the Trash.
2. Choose Empty Trash from the Special menu.

Retrieve an item
from the Trash

1. Open the Trash icon.
2. Drag the icon out of the Trash (and into the disk or folder window where
you want to store it). Or, choose Put Away from the File menu to return
the icon to its original place on a disk.

Working with windows
A window opens when you double-click an icon. A window usually shows
you what’s inside an icon.
Click the close box
to close a window.

Click the zoom box
to resize a window.
Click the scroll arrows to view
contents that you cannot see.

This is a window showing
you what’s on the the hard
disk named “Macintosh HD.”
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Drag the size box to
enlarge or reduce
the window.

Move the scroll box up or down
to view the contents of a window
that you can’t see. The gray in
the scroll bar indicates that there
are contents of the window that
you cannot see.

Viewing the contents of a window
To do this

Follow these steps

View the contents
of a window by name,
date, size, or kind

1. Open the View menu.
2. Choose the menu item that corresponds to the way you want to
view the contents of the window.

View the contents of
the window in outline
form

1. Choose any list view from the View menu (any view except the
icon and small icon views).
2. Click the triangle next to a folder name to display or hide the
contents of the folder.

Making a window active
To do this

Follow these steps

Make a window
active

Click anywhere inside the window or double-click its icon.

Opening higher level folders or disks
1 Hold down the x key as you press
the title of the active window.
2 Drag to choose a higher-level folder
(or disk) and then release the button.
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Working with documents
Opening and closing a document
To do this

Follow these steps

Open a document

1. Click the icon for the document.
2. Choose the Open command from the File menu.
Or double-click (click twice rapidly) on the icon.

Close a document

Choose Close from the File menu. Or click the close box of the
document window.

Opening a document from within a program
To do this

Follow these steps

Open a document
when you are working
in an open program

1. Choose Open from the File menu.
2. Click the name of the document. (The illustration
shows how to find a folder that you might not see.)
3. Click the Open button.
Press this label to open a pop-up
menu of folders and disks.

The documents in the
disk or folder you
choose are listed here.
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Saving and naming documents
To do this

Follow these steps

Save and name a
document for the
first time

1. Choose the Save command from the File menu.
2. Type a name for the document.
3. Click the Save button.

Save the document
under another name
(Save as)

1. Choose the Save As command from the File menu.
2. Type a new name for the document.
3. Click the Save button.

Choosing a folder when saving a document
To do this

Follow these steps

Save a document while 1. Choose Save or Save As from the File menu.
working in a program
2. Click the name of the folder you want to save your document in. (The
illustration shows how to find a folder that you might not see.)
3. Click Open to open the folder.
4. Name your document.
5. Click the Save button to save the document inside the folder.
Press this label to open a pop-up
menu of folders and disks.

The documents in the
disk or folder you
choose are listed here.
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Working with disks
Inserting a floppy disk

Insert metal end first,
label side up.

Preparing a new floppy disk for use
See “Using Disks” in the Macintosh Reference manual.

Ejecting a floppy disk
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To do this

Follow these steps

Eject a floppy disk

Drag the disk’s icon to the Trash.

Copying the contents of a disk
To do this

Follow these steps

Copy the entire
contents of one floppy
disk onto another floppy
disk (with one disk drive)

1. Insert the original floppy disk into the floppy disk drive.
2. Drag the floppy disk icon to the hard disk icon. (The floppy disk
contents appear in a folder on the hard disk.)
3. Drag the floppy disk icon to the Trash.
4. Insert the floppy disk that you want to copy to.
5. Drag the icon of the newly created folder to the floppy disk icon.
6. Drag the floppy disk icon to the Trash.

Copy the entire contents
of one floppy disk onto
another floppy disk (with
two disk drives)

1. Insert both floppy disks into the disk drives.
2. Drag the icon for the source disk (the disk you are copying from)
to the icon for the destination disk (the disk you are copying to).

Copy an entire floppy
disk onto a hard disk

1. Drag the icon for the floppy disk to the icon for the hard disk.
(The floppy disk contents appear in a folder on the hard disk.)

Copy items from a
hard disk onto
a floppy disk

1. Select the items you want to copy.
2. Drag the selected icons to the floppy disk’s icon or window.

Copy items from a
floppy disk onto a
hard disk

1. Select the items you want to copy.
2. Drag the selected icons to the hard disk’s icon or window.

Erasing the contents of a disk
To do this

Follow these steps

Erase the entire
contents of a floppy
disk

1.
2.
3.
4.

Insert the disk you want to erase into a disk drive.
Click the icon of the disk you want to erase.
Choose Erase Disk from the Special menu.
Respond to the messages on your screen by clicking the
appropriate buttons.
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Organizing your desktop
Creating a new folder
To do this

Follow these steps

Create a new
folder

1. Choose New Folder from the File menu.
2. Type a name for the folder.
3. Press the Return key.

Placing an icon inside a folder
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To do this

Follow these steps

Place an icon
inside a folder

1. Drag the icon to the folder where you want to store it.
2. Release the button when the folder icon becomes
highlighted.

Working with pull-down menus
To choose an item from a menu:
1 Point to the menu.
2 Press to pull down the menu.
3 Drag to the item you want to choose.
4 Release the button when the
command is highlighted.

This is the Help menu,
which you use to display
information about items on
the screen.
This is the Application menu,
which you use to see which
programs are open.

Dimmed commands
are not available.
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Keyboard shortcuts in the Finder and in directory dialog boxes
Key

Action

Up, Down, Left,
or Right Arrow key

Selects the next item in the direction of the arrow

Tab key
key (a, b, c...)

Selects the next item alphabetically (except in a directory dialog box
and the Chooser)

Character

Selects the first item whose name begins with that character (or the
character following closest to it in the alphabet)

x–Down Arrow

Opens the selected icon

x–Option–Down Arrow Opens the selected icon and closes the current folder
x–Up Arrow

Opens the folder that contains the current folder

x–Option–Up Arrow

Opens the folder that contains the current folder and closes the current
folder

Return or Enter

In a dialog box: the same as clicking the button with the bold outline
In the Finder: selects the selected icon’s name for editing or saves the
edited name
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More About Your Macintosh
Chapter 5

Expanding Your Computer and
Connecting Other Equipment

Chapter 6

Using Software With Your
Power Macintosh

Chapter 7

Using Stereo Audio

Chapter 8

Using Video With Your
Power Macintosh 8100/80AV

Part II contains information you’ll need after you’ve
set up your computer and learned Macintosh basics:
m Installing an expansion card or additional memory,
and connecting other equipment
m Using Power Macintosh software programs, which
have special memory requirements
m Using your computer’s stereo audio capabilities
m Using video on an AV-equipped Power Macintosh
Before you follow the instructions in this section,
you should have set up your computer as described
in Part I of this book and (if you are new to the
Macintosh) have gone through the learning materials
in Chapter 3.

II
part

Read this chapter for information on
adding a NuBus card or connecting
other equipment to your computer

5

Expanding Your Computer and
Connecting Other Equipment

Installing an expansion card
You can install printed circuit boards (called cards) for video and graphics
applications, networking and communications, additional processing power,
or other purposes. The cards fit into connectors, called expansion slots, inside
the computer.
Your Macintosh has three expansion slots, each designed to accept a NuBus™
card.
WARNING Be sure to use the Macintosh NuBus Adapter designed
specifically for your model of the computer. Failure to do so could
damage the card and your computer.

WARNING Do not remove any factory-installed cards from inside your

computer. Pulling a factory-installed card out at an angle can damage
your equipment. Any NuBus expansion card you install will not
operate properly if the factory-installed card has been removed. If a
factory-installed card needs to be removed, see an Apple-authorized
service provider.
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Installing a card with a DAV connector in your
Power Macintosh 8100/80AV
If you have a Power Macintosh with built-in AV capabilities, you can install a
NuBus card that contains a Digital Audio and Video (DAV) connector. This
connector provides direct access to the specialized digital video and audio
hardware built into your computer.
The illustration below shows the location of the expansion slots in your
computer. If you wish to install a NuBus card that contains a DAV connector,
you must use the indicated expansion slot (the one nearest the center of the
computer’s case).

The card in this slot contains a port
that accepts a DAV connector
(Power Macintosh 8100/80AV only)
Use this slot to install a NuBus card
that contains a DAV connector.

NuBus expansion slots (3)
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NuBus power requirements
The combined power consumption of NuBus cards must not exceed the limits
specified for your Macintosh model. If you have more than one NuBus card
installed, check the information that came with your cards to make sure that
their power consumption is within the limits specified in the Technical
Information booklet.

Installing a NuBus card
IMPORTANT Some cards may need to be installed by an Apple-authorized

service provider. Check the information that came with the card.
Follow these steps to install a NuBus expansion card or a DAV card.
1

Turn off the computer.

Make sure the computer is plugged in and turned off.
2

Loosen the four large screws at the corners of the back panel.

Do not remove the screws or the back panel.
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3

Remove the cover from the computer.

Slide the cover away from the back panel an inch or two. Then raise the cover
straight up and off the computer.

62

Chapter 5

4

Touch the metal part of the power supply case inside the computer to discharge static
electricity.

Always do this before you touch any parts or install components inside the
computer.
Power supply
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5

Remove the expansion card clip.

Grasp the clip handles with your thumb and forefinger and squeeze. Pull the
clip straight out.

6
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Pull out the plastic cover plate behind the expansion slot you want to use, and set the
cover plate aside.

7

Remove the card from its static-proof bag.

Hold the card by its top edge to avoid touching the connector on the bottom of
the card.
Connector

8

Align the connector end of the card with the expansion slot.

Connector

Expansion slot
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9

Press the card firmly until the connector is seated.

m Don’t force the card. If you meet a lot of resistance, pull it out and
try again.
m To see if the card is properly connected, wiggle it gently. If it resists and
stays in place, it’s connected.
If you have other cards to install, put them in now by repeating steps 6
through 9.
10

Replace the expansion card clip.

Put the bottom of the clip in place first. Make sure the edge of the expansion
card fits into one of the slots on the clip.
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11

Replace the cover on the computer.

Lower the cover all the way down onto the case. Push the cover back until it
touches the back panel.

12

Tighten the screws on the back panel.
WARNING Always replace the cover before turning the computer on.
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Expanding memory
The random-access memory (RAM) in your computer can be expanded by
adding Single Inline Memory Modules (SIMMs) to those already installed or
by exchanging installed modules for ones that have greater storage capacity.
In the Power Macintosh 8100/80, the memory used to display images on the
screen (called video RAM, or VRAM) can also be expanded. In the
8100/80AV, VRAM cannot be expanded.
Make sure that SIMMs you purchase for memory expansion are the correct
ones for your Macintosh. SIMMs for your model of Macintosh must be
installed in pairs of the same size into paired slots. See the Technical
Information booklet for details.
WARNING Apple recommends that additional memory on the main

circuit board should be installed by an Apple-authorized service
provider or technician. Modification of the circuit board by anyone
except a qualified technician voids your warranty and could damage
your computer.

Installing other internal devices
Your Macintosh holds up to three internal storage devices, including a floppy
disk drive, a CD-ROM drive, and a hard disk drive (several capacities are
available). See your Apple-authorized dealer for information about adding
internal equipment to your Macintosh.
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Your computer at a glance
The illustrations on this page and the next pages provide a detailed look at
your Macintosh hardware, including the ports you use to connect external
equipment.
Monitor
(See the Macintosh
Reference for information on
adjusting screen brightness
and displaying color.)

CD-ROM drive
(optional)
Floppy
disk drive

Keyboard
(See the Macintosh
Reference for information on
adjusting keyboard height.)

Hard disk drive
(internal)
Power on light

Mouse
Interrupt switch ¥
Reset switch P
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SCSI port
Connects your Macintosh to SCSI devices such
as hard disk drives, scanners, and printers.

g

Ethernet port
Connects your Macintosh to a high-speed network.

G

High-density monitor port
Connects a monitor to your Macintosh.

™

Printer port
Connects your Macintosh to a printer,
LocalTalk network, or GeoPort Adapter.

[

Modem port (GeoPort)
Connects an external modem or
GeoPort Adapter to your Macintosh.

W

ADB port
Connects your Macintosh to input
devices, such as a keyboard or a trackball.

V

Sound output port
Connects your Macintosh to headphones,
speakers, or other audio output devices.
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I

≤

Power switch

Power socket

Monitor
power
socket

Monitor port
Connects a
monitor to your
Macintosh.

Expansion
slots (3)

F

Security lock ports

≈ Sound input port
Connects your Macintosh to a microphone
or other audio input device.

Power Macintosh 8100/80AV computer
SCSI port
Connects your Macintosh to SCSI devices such
as hard disk drives, scanners, and printers.

g

Ethernet port
Connects your Macintosh to a high-speed network.

G

High-density monitor port
Connects a monitor to your Macintosh.

™

Printer port
Connects your Macintosh to a printer,
LocalTalk network, or GeoPort Adapter.

[

Modem port (GeoPort)
Connects an external modem or
GeoPort Adapter to your Macintosh.

W

ADB port
Connects your Macintosh to input
devices, such as a keyboard or a trackball.

V

Sound output port
Connects your Macintosh to headphones,
speakers, or other audio output devices.

_

I

Power switch

≤

Power socket

Monitor power
socket

Monitor port
Connects a
monitor to your
Macintosh.

Expansion
slots (3)

F

Sound input port ≈
Connects your Macintosh to a microphone
or other audio input device.

Security lock
ports

Camera and S-video input port
Connects your Macintosh to a video camera, VCR,
or other video equipment that uses the S-video format.
Adapters for composite video format are supplied.

S-video output port
Connects your Macintosh to a VCR or other video equipment
that uses the S-video format. Adapters for composite video
format are supplied.

Expanding Your Computer and Connecting Other Equipment

71

Connecting hard disks and other SCSI devices
Your computer has a port for connecting devices that use the Small Computer
System Interface (SCSI, pronounced “skuh-zee”). The SCSI port permits
high-speed communication between the computer and the device. The SCSI
icon appears above the port on the computer’s back panel.
SCSI icon

SCSI port

IMPORTANT Follow the instructions in this section and the instructions that

came with your hard disk or other SCSI device when connecting it to your
Macintosh.
SCSI devices commonly used with the Macintosh include hard disks,
CD-ROM drives, scanners, printers, and tape backup drives.
Your computer comes with one SCSI device already installed—your internal
hard disk. You can connect up to six additional SCSI devices in a chain. Each
device must have its own, unique ID number.
Setting up a SCSI device to use with your Macintosh involves
m installing any necessary device drivers
m setting the device’s SCSI ID number
m physically attaching the device to your Macintosh
Note: Your computer has a second, internal SCSI connector to suppport an
internal hard disk array. If you wish to install a hard disk array, contact an
Apple-authorized service provider for assistance.
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Installing a device driver
A device driver is software that lets the Macintosh communicate with a
particular SCSI device.
To install a driver:
m Drag the driver icon to the System Folder icon on your startup disk.
Any drivers needed for a SCSI device are usually on a floppy disk that comes
with the device. (If no drivers come with the device, then it doesn’t need any.)
You may have to restart your Macintosh to activate the driver.

Setting the SCSI ID number
See the instructions that came with your SCSI device for information on
setting its SCSI ID number.
WARNING Each SCSI device connected to your Macintosh must have its
own, unique ID number between 1 and 6. Using two or more devices
with the same ID number can cause your equipment to malfunction. You
could lose data as a result.

If you have an Apple SCSI device, set the SCSI ID number as follows:
1

Make sure the device is switched off.

2

Choose a number between 1 and 6 that hasn’t been assigned to any other SCSI device
connected to your Macintosh.

Your internal hard disk’s ID number is preset to 0, and your Macintosh itself
has the ID number 7.
If your computer came with an internal CD-ROM drive already installed, its
SCSI ID number is preset to 3.
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3

Locate the ID number switch on the back of your SCSI device.

SCSI ID switch

4

Push the ID switch repeatedly until the number you want appears.

On some SCSI devices, the ID number switch is inside a small hole. Insert a
straightened paper clip to push the switch.

Attaching a SCSI device
To connect a SCSI device to your Macintosh:
1

Turn off your Macintosh.

2

Make sure the SCSI device is switched off.
WARNING Do not connect or disconnect any device while the device or

your Macintosh is turned on. Doing so could damage the device, your
computer, or both.
3
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Make sure the device has its own, unique ID number between 1 and 6.

4

Use a SCSI cable to connect the device either to the computer’s SCSI port or to the last
SCSI device already in the chain.

If the device is the first or only one you’re connecting, use a SCSI system
cable to connect it to the computer’s SCSI port.

If the device is not the first one, use a SCSI peripheral interface cable to
connect it to the last device in the chain.

IMPORTANT The total length of the cables in a SCSI chain should not exceed

6 meters (20 feet). SCSI cables must have a 110-ohm impedance. For best
results, use SCSI cables manufactured by Apple Computer.
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5

Make sure that the last (or only) device in the SCSI chain has a terminator. Make sure
that no other external SCSI device has a terminator.

To ensure accurate transmission of information, a terminator must be at each
end of a SCSI chain. Your internal hard disk, which is the first device in the
chain, has a built-in terminator.
Some external SCSI devices from manufacturers other than Apple have a
built-in terminator. (Check the information that came with the device.) If the
device at the end of the SCSI chain does not have a built-in terminator, you
need to attach an external terminator.

SCSI terminator

Have your Apple-authorized service provider remove any extra built-in
terminators. You can attach or remove external terminators yourself.
Tip: If only one external device has a built-in terminator, rearrange the SCSI
chain so that device is at the end.
IMPORTANT Always turn on any external SCSI devices connected to your

Macintosh before turning on the computer itself. Otherwise, your computer
cannot recognize the SCSI devices.
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Connecting a printer
Your Macintosh has a printer port, which you use to connect a printer to your
computer.
Printer port icon

Printer port

The printer port accepts either a direct cable connection (to printers such as
the StyleWriter II) or a network cable connection (to printers such as a
LaserWriter Pro or LaserWriter Select).
Follow the instructions that came with your printer when connecting it to
your Macintosh.
A printer can also be connected to the modem port. You use the Chooser
program to indicate the port you used to connect your printer. (See the
Macintosh Reference for more information on using the Chooser.)
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Connecting an additional monitor
You can connect two monitors to your computer without installing an
additional card. See the instructions that came with your monitor and
“Connecting a Monitor” in Chapter 1.
When you connect an additional monitor:
m Make sure that the ventilation openings on the computer and the monitors
are clear and unobstructed.
m If there is interference on your screens or on a television or radio near your
Macintosh, separate or reposition the affected equipment.

Connecting a trackball or other input device
Your computer has an Apple Desktop Bus (ADB) port, which you use to
connect the mouse, the keyboard, and other input devices such as a trackball,
a bar-code reader, or a graphics tablet.
ADB port icon

ADB port

You can connect up to three ADB devices in a chain to a single port. The
exact number depends on how much power the devices require.
IMPORTANT The total power used by all ADB devices connected to your

Macintosh must not exceed 500 milliamperes (mA). Information about the
power requirements of the mouse and keyboard are in the Technical
Information booklet that came with your computer. Check the information
that came with your other ADB device for power requirements.
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Connecting a microphone
Your computer has a sound input port, which you can use to connect a
microphone. With appropriate software, you can use the microphone to give
spoken commands to your Macintosh and to record your voice or other
sounds.
The Apple PlainTalk Microphone and the software needed for using spoken
commands are available from Apple-authorized dealers. If you want to use
another microphone, make sure it is compatible with your model of
Macintosh.

The Apple AudioVision 14 Display has the Apple PlainTalk Microphone
built in.
To connect the microphone:
m Plug the microphone’s connector into the sound input port (marked with the
symbol X) on the back of the computer.

See “Connecting Stereo Audio Equipment” in Chapter 7 of this book for
more information about the sound input port.

Expanding Your Computer and Connecting Other Equipment

79

Connecting a GeoPort Telecom Adapter or modem
Your Macintosh has an enhanced telecommunications port called the
GeoPort. By connecting the GeoPort Telecom Adapter, designed specifically
for use with the GeoPort, you can take advantage of your computer’s special
communications capabilities. The GeoPort Telecom Adapter comes with
communications and fax software and can be purchased from Appleauthorized dealers.
Modem and GeoPort icon

GeoPort connector

You can also connect a standard modem to the GeoPort, using a standard
modem cable. A standard modem cannot take advantage of the computer’s
advanced communications features.
To connect an adapter or modem to your computer, follow the instructions
that came with your adapter or modem.
You can also connect a printer to the modem port.

Connecting to a high-speed network
Your Macintosh comes with built-in Apple Ethernet for connecting to highspeed Ethernet networks. With the appropriate Apple Ethernet Media
Adapter (or another compatible media adapter), you can connect your
Macintosh to an existing Ethernet network, using thin coax, 10BASE-T
twisted pair, thick coax, or other standard cables. (See your Apple-authorized
dealer for more information on Apple Ethernet Media Adapters for your
Macintosh.)
IMPORTANT Your Macintosh supports EtherTalk Phase 2 (AppleTalk Phase 2

protocols for Ethernet networks) and TCP/IP. The computer does not support
EtherTalk Phase 1.
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Connecting to an Ethernet network
You can connect an adapter and cable for an Ethernet network directly to the
computer, without installing an expansion card.
The Ethernet port is identified with this symbol: G.
Ethernet icon

Ethernet port

To connect a cable to the Ethernet port, follow the instructions that came with
the Ethernet adapter you want to use. If you need assistance, consult a
network administrator or other technical expert.
Once you’ve connected to an Ethernet network, you need to choose Ethernet
in the Network control panel. See the networking chapter of the Macintosh
Reference for instructions.

Connecting to a Token Ring network
By installing the appropriate expansion card, you can connect your Macintosh
to a Token Ring network. Consult the documentation for your Token Ring
expansion card and software for instructions.
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Attaching a security lock
You can attach a security lock to your Macintosh to deter theft. The back
panel has a built-in port for a security lock.

F Security
lock ports

Follow the instructions supplied with the security lock to attach it to your
computer.
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Refer to this chapter for information
on programs designed for Power
Macintosh computers

6

Using Software With Your Power Macintosh

Using Power Macintosh application programs
Your Power Macintosh is compatible with most software programs intended
for use with Macintosh computers. But certain programs are designed
especially for Power Macintosh computers. You’ll find that these programs
take best advantage of your computer’s speed.

Special memory requirements
Some Power Macintosh programs may be slightly larger than other programs,
and may take up more memory. If you find that you are running out of
memory when you use your Power Macintosh programs, you can use space
on your computer’s hard disk as additional memory. This feature is called
virtual memory. See “Using Hard Disk Space As Memory” in the Macintosh
Reference.
You can also add more memory to your computer as described in Chapter 5
of this book.
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Shared libraries
Power Macintosh programs use special files called shared libraries. These files
help Power Macintosh programs to run more efficiently, and can be used by
more than one Power Macintosh program simultaneously. Any necessary
shared libraries are installed automatically in the System Folder when you
install Power Macintosh programs.
If a Power Macintosh program requires a shared library and there is not
enough memory available for the shared library, you’ll see a message that the
program could not be opened because there is not enough system memory
available for the shared library. If this happens, turn on virtual memory as
described in the Macintosh Reference.
If a required shared library is missing, you’ll see a message that the program
could not be opened because the shared library could not be found. If this
happens, follow the directions that came with your program to reinstall the
program. If the shared library is still missing, contact the software program’s
manufacturer for assistance.
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Using older Macintosh programs
If you experience problems using an older Macintosh program, it may be
incompatible with your Power Macintosh. You may be able to use your older
program if you change the Memory Manager setting in your Memory control
panel. Follow these steps:
1

Choose Control Panels from the Apple (K) menu and open the Memory control panel.

2

Turn off Modern Memory Manager.

Click here to turn off
Modern Memory Manager.

When you are finished using the program, open the Memory control panel
again and turn Modern Memory Manager back on.
For best performance, contact the program’s manufacturer for an upgrade.
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The software programs that came with your computer
Your computer has several application programs already installed. You’ll find
these programs in the Apple Extras folder on your hard disk. One of the
programs, Video Monitor, is for use with computers that have AV capabilities.
Video Monitor is described in Chapter 8 of this book.
The Guide to Apple Extras in the Apple Extras folder contains information
about the programs supplied with your computer. To read about the programs,
open the Apple Extras folder and double-click on the Guide to Apple Extras
icon.
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Read this chapter to learn how to
use stereo audio equipment
with your computer

7

Using Stereo Audio

Your Macintosh produces stereo sound and provides several options for highquality audio.
When an audio device is connected to the sound input port, you can hear or
record the incoming sound on the computer.
When an audio device is connected to the sound output port, you can record
the sound produced by the computer or play that sound through external
speakers.
This chapter explains how to connect stereo equipment to your Macintosh.
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About your computer’s sound ports
Your Macintosh can play and record stereo sound from a variety of sources.
To provide or reproduce stereo sound, you can connect audio devices to the
sound input and output ports on the computer. If you have an internal
CD-ROM drive, you can also use it to play and record sound from audio
compact discs (CDs).
The sound input port is identified with an icon of a microphone. The sound
output port is identified with an icon of a speaker.
Sound output port

Sound input port

The computer’s sound ports accept an audio connector known as a stereo
miniplug. This connector is the type used on headphones for a personal tape
player, for example. If your equipment uses a different type of connector, you
can purchase an adapter at an electronics supply store.

Stereo miniplug
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Connecting an audio device
To play or record sound with your Macintosh, you can attach a microphone,
amplifier, tape recorder, or a pair of speakers.
If your Macintosh has AV capabilities, you can record sound and video
simultaneously by connecting a VCR to the S-video output port and linking
the computer’s sound output port to the sound input channels on the VCR.
(See “Connecting a VCR to View Video Images or Capture Frames” in
Chapter 8.)
Follow these steps to connect an audio device to the Macintosh.
1

Make sure that the audio device has a cable with a stereo miniplug connector.

If not, attach an adapter that has a stereo miniplug.
2

Place the audio device near the Macintosh.

3

Shut down the Macintosh and turn off the audio device.

4

Attach the cable to the audio device and to the sound port on the Macintosh.

5

Turn on the computer and the audio device and begin working with sound.

About microphones: Be sure to use a microphone designed for your model of
the Macintosh, such as the Apple PlainTalk Microphone. You can obtain
information about other microphones from an Apple-authorized dealer.
The Apple PlainTalk Microphone and the software needed for using spoken
commands are available from Apple-authorized dealers.
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Choosing audio input options
You use the Sound control panel to choose the audio input device and options
you want.
Follow these steps to choose the sound input device.
1

If you want to use an external device for sound input, connect it to the sound input port
following the instructions in the previous section.

2

Open the Sound control panel and choose Sound In from the pop-up menu.

The Sound control panel is in the Control Panels folder in the Apple (K)
menu.

The Built-in icon (the
preset choice)
stands for the
computer.
Click the Options button to
see other choices.

3

To change the selected sound input device, click the Options button.

The Input Source options appear.
If you click
Play-Through, sound
from the selected input
device plays through
the computer’s
speaker or through the
device connected to
the sound output port.

Click a sound source.

The microphone icon stands for the device connected to the sound input port.
The AV Connector icon appears if you have an AudioVision monitor.

90

Chapter 7

4

Click the button for the audio device you want to hear, then click OK.

If you have software for using spoken commands with your computer, please note:
m To use an AudioVision monitor’s microphone for spoken commands, select
the AV Connector icon in the Input Source options.
m To use a microphone connected to the sound input port for spoken
commands, select the Microphone icon.
m If Play-Through is selected, you won’t be able to give spoken commands to
the computer.

Choosing audio output options
You use the Sound control panel to designate the audio output device and
options you want.
Follow these steps to direct the computer’s sound to an output device.
1

If you want to use an external device for sound output, connect it to the sound output
port, following the instructions under “Connecting an Audio Device.”

2

Open the Sound control panel and choose Sound Out in the pop-up menu.

The Sound control panel is in the Control Panels folder in the Apple (K)
menu.

The Built-in icon (the
preset choice) stands
for the computer.
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3

Click the icon that represents the source of sound output.

About the sample rate: Most of the time you will not need to change the
sample rate. Use the Rate pop-up menu to change the sample rate only if the
sound you wish to play was recorded at a sample rate different from the
current setting. For instance, if you play a QuickTime movie containing sound
recorded at 44.1 kHz, set the sample rate in the Rate pop-up menu to 44.1 to
hear the full quality of the sound. Increasing the sample rate slows
performance.
m Do not set the sample rate higher than the sample rate of the sound you are
playing, since this slows your computer’s performance without improving
sound quality.
m Do not change the sample rate if playthrough is in effect.
m Do not change the sample rate for sound coming from a device connected
to the sound input port.
The other options cannot be changed. If you use a program that provides
sound recording in mono format, you can use its mono setting.
4

Close the Sound control panel.

Recording an alert sound
Although your Macintosh can produce stereo sound, the computer records
alert sounds in the same way as other Macintosh models: in 8-bit mono
sound, at a sample rate of 22.254 kHz. This makes the alert sounds you
record compatible with all Macintosh computers. See the Macintosh Reference
for instructions on recording an alert sound.
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Connecting external stereo speakers
You can take advantage of your computer’s stereo sound output by attaching
external powered (amplified) speakers.
1

Assemble the speakers and the cable you need.

You need a cable with stereo miniplugs at each end to connect one or both
speakers to the computer. (Some speakers require a dual-plug adapter.
Others, like those shown here, accept a single stereo miniplug and are joined
by standard speaker wires.)
The illustration below shows the equipment configuration and the
connections for a computer sound system.
Sound
output
port
Powered
speakers

Audio In port

2

Turn off the Macintosh.

3

Plug a stereo miniplug into the sound output port on the Macintosh.

4

Plug a stereo miniplug into the Audio In socket on one of the speakers.

If the speakers take a dual-plug cable, connect both plugs.
5

Connect the speakers together with speaker wires, if necessary.

6

Turn on the computer.

Now you hear the computer’s sound through the external speakers.
Note: To control the volume of your external speakers, open the Sound
control panel and choose Volumes in the pop-up menu. Use the Built-in
Headphones slider to adjust your external speakers. If you are playing an
audio CD, you may also need to adjust the volume control in the program
you’re using to play CDs.
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Playing audio CDs
If your Macintosh has an internal CD-ROM drive or you connect an external
CD-ROM drive or CD player, you can use audio CDs with the Macintosh.
Follow these steps to play CD audio sound through the computer’s internal
speaker.
1

Place an audio CD in the CD-ROM drive or CD player.

See the information that came with your equipment for details about inserting
a CD.
2

Use the Sound control panel to choose the CD-ROM drive or CD player as the sound
input device and click Play-Through to hear the CD.

3

Use your audio CD software to play the CD.

If you have either the CD Remote or AppleCD Audio Player program, choose
the program from the Apple (K) menu and click Play.
See the instructions that came with your CD-ROM drive for more information
about playing audio CDs.
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Read this chapter to learn how to
use video equipment with your
Power Macintosh 8100/80AV

8

Using Video With Your
Power Macintosh 8100/80AV

You can connect video equipment to your Power Macintosh 8100/80AV. You
can display, edit, and store video images on the computer, and view or record
the computer’s images on a television or video recorder (VCR). This section
provides the information you need to
m Connect video equipment for input, so you can display the video image on
your monitor, capture single frames, or save digitized video in files.
m Connect video equipment for output, so you can display or record what’s on
the computer’s screen.
m Display the computer’s images on a television.
m Adjust settings for video input or output.
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Example of a Macintosh system for working with video
If your Macintosh is equipped with AV capabilities, you can create a powerful
system that combines computing, video, stereo audio, and
telecommunications.

GeoPort Telecom
Adapter

Video camera

Videocassette recorder
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About your computer’s video ports
Your AV-equipped Macintosh can display and use video images from a variety
of sources. To view video on your monitor, you connect a video device to the
video input port on the computer. To display or record the computer’s output,
you connect a video device to the video output port.
The Macintosh can work with two major video formats:
m S-video
m Composite video
S-video is a high-quality video format used by many video cameras and
VCRs. Televisions, most videocassette recorders, and laserdisc players use the
composite format.

The S-video input and output ports
The illustration below shows the location of your computer’s S-video input
and output ports.
S-video
output port

S-video
input port
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S-video connectors
The S-video connector is a round plug with several small metal pins.
S-video connector. You can plug this type
of connector into your computer’s S-video
input or output ports.

IMPORTANT The S-video connector resembles other Macintosh connectors,

such as those for a printer, modem, mouse, or keyboard. Don’t confuse the
connectors; they are not interchangeable.

Adapters for composite video
Many video devices use composite video format instead of S-video. The
cables for these devices have RCA-type plugs, as shown below.

RCA plug. Use the adapters that come
with your computer to plug this type of
connector into your computer’s S-video
input or output ports.
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Two adapters for composite (RCA-type) video connectors come with your
computer. To connect a cable with RCA plugs to your computer, connect the
RCA plug to one of the adapters, and connect the adapter to the appropriate
S-video port (input or output) on the back of your computer.
Connect the end marked with the Æ icon
to the computer’s S-video output port.
(The connector should have the flat part
pointing up, as shown here.)

To record images from your computer on a
VCR or other video device, attach the end
of the adapter marked with the Â icon to a
cable with RCA plugs, then connect the
cable’s other RCA plug to the video input
port on the video device.

Connect the end marked with the æ icon
to the computer’s S-video input port.
(The connector should have the flat part
pointing up, as shown here.)

To view images from your VCR or other
video device on your monitor, attach the
end of the adapter marked with the ˜ icon
to a cable with RCA plugs, then connect
the cable’s other RCA plug to the video
output port on the video device.
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Connecting a VCR to view video images or capture frames
The steps that follow tell you how to connect a stereo VCR to the Macintosh
so that you can view video or capture a single video frame and hear the sound
from the VCR through the computer’s speaker. You can use these instructions
as a model for connecting your equipment to any video device.
Before you start:
m Make sure that the VCR has a cable with either a composite (RCA plug)
connector or an S-video connector.
If the VCR has an RCA plug, make sure you have the adapter for
composite video marked with the ˜ icon.
m Place the VCR near the Macintosh.
m Shut down the Macintosh and turn off the VCR.
Then follow these steps:
1

Assemble the cables you need to connect the VCR to the Macintosh.

You need the following cables (available at an electronics supply store):
m Video cable with S-video connectors or RCA plugs at each end.
S-video

S-video

RCA

RCA

Adapter for composite video

S-video

m Audio cable with dual RCA plugs at one end and a stereo miniplug at the
other end.
RCA
Stereo miniplug

You can also use an all-in-one cable (with one video and two audio RCA
plugs at each end) if you attach appropriate adapters.
IMPORTANT A Y-shaped adapter is supplied with the round microphone for

some models of the Macintosh. This adapter is not compatible with your
Macintosh.
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2

Attach one end of the video cable to the Video Out socket on the VCR (follow the
directions that came with the VCR).

3

Plug the other end of the video cable (or adapter) into the S-video input port on the
Macintosh.

If the connector doesn’t slide easily into the port, realign it and try again.
Using force could damage the computer or cable.
4

Plug the RCA connectors on the audio cable into the left and right Audio Out sockets on
the VCR.

5

Plug the stereo miniplug on the audio cable into the sound input port on the Macintosh.

For more information about the sound input port and the stereo miniplug, see
Chapter 7.
The illustration below shows the correct connections.
Sound input
port

S-video input
port
Video Out
port

Audio Out ports
(left and right)
VCR

3.5 mm miniplug to dual RCA-plug cable
(available at most electronics supply stores)

6

Turn on the computer and the VCR.

You can now begin working with the video equipment connected to your
Macintosh. The next two sections explain how to view video on the screen
and capture a single frame.
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Opening a video window on the screen
Using the Video Monitor program provided with your Macintosh, you can
view video on the screen and capture a single video frame.
You’ll find the Video Monitor program in the Apple Extras folder on your
hard disk. Refer to the Guide to Apple Extras, also in the Apple Extras folder,
for additional information about Video Monitor.
Follow these steps to see video on the computer screen.
1

Make sure that a video device is connected to the video input port.

If you need to connect a device, turn off both the computer and the video
equipment first.
2

Open the Apple Extras folder on your hard disk and locate Video Monitor.

3

Double-click the Video Monitor icon to start the program.

The Monitor window appears. If the video device is already on and is playing,
its images appear in the window.
4

Turn on the video device and play an image (usually by pressing the Play button).

The video image appears inside the Monitor window. If you don’t see an
image, continue with step 5. Otherwise, skip ahead to “Video Images and
Memory Allocation.”

IMPORTANT If your monitor has a 21-inch screen (resolution of 1152 x 870) or

a 19-inch screen (resolution of 1024 x 768), the video image will appear in
256 shades of gray.
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5

If no image appears in the Monitor window, choose Video Settings from the Monitor
menu.

The Video window appears.
6

Choose Source from the pop-up menu at the top left side of the Video window.

New choices appear in the window.

Video appears here
(the box is black if
no video is being
received).

7

Change the choice in the Input pop-up menu or the Format pop-up menu.

m The Input choices indicate the input port for the video device. The preset
choice is composite video.
m The Format choices indicate the format, or standard, of the video signal.
The preset choice is NTSC, which is used in the U.S. and Japan.
If after choosing the correct input and format you still don’t see an image in
the video window, check that you’ve connected the video device correctly, that
it is turned on, and that it is playing.
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Video images and memory allocation
When you display video images using Video Monitor or another program, the
video images use a portion of the computer’s screen memory (also called
video RAM, or VRAM).
If you see a message in the Monitor window stating that video is turned off,
you need to set the monitor to display fewer colors or grays. This allows the
computer to allocate additional memory to the video image.
You use the Monitors control panel to change the number of colors or grays
displayed. See the Macintosh Reference for instructions.

Capturing one frame of a video image
You can capture a single video frame to use in presentations or documents.
Follow these steps:
1

Display a video image on the screen, using the Video Monitor program.

See “Opening a Video Window on the Screen” earlier in this chapter.
2

Choose Copy from the Edit menu.

One frame of the video image will be copied to the Clipboard or saved as a
PICT file (a common graphics format). You can then paste the frame into a
graphics program, edit it, and save it.
If you see a message that there is not enough memory to copy the frame, try
reducing the size of the video window.
IMPORTANT Prerecorded videotapes, broadcast video programs, and other

prerecorded images, movies, and sound, whether in video, audio, or digital
form, may be proprietary and protected by copyright. If you want to use
prerecorded materials, you may need to obtain the consent of the copyright
owner or seek the advice of a lawyer.
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Recording video movies
You can purchase application programs that allow you to record, play, and edit
video segments. Several utility programs for working with video and
animation are included in the Apple QuickTime Starter Kit, available from
Apple-authorized dealers.
Video images occupy large amounts of memory and disk space. You may
want to increase the amount of RAM and disk storage in your Macintosh if
you plan to work with video frequently.

Recording a computer presentation on videotape with voice annotation
You can deliver and record a sophisticated presentation by combining the
video and sound capabilities of your Macintosh. The steps that follow tell you
how to set up equipment for recording the computer’s output on videotape
and adding voice annotation with a microphone.
You can use these instructions as a model for connecting your equipment to
record video output and voice.
Before you start:
m Make sure that the VCR has a cable with either a composite (RCA plug)
connector or an S-video connector.
If the VCR has an RCA plug, make sure you have the adapter for
composite video marked with the Â icon.
m Place the VCR near the Macintosh.
m Shut down the Macintosh and turn off the VCR.
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Then follow these steps:
1

Assemble the VCR, television, microphone, and cables you need.

Be sure to use a microphone designed for your model of the Macintosh, such
as the Apple PlainTalk Microphone.
You need the following cables (available at an electronics supply store):
m Video cable with S-video connectors or RCA plugs at each end.
S-video

S-video

RCA

RCA

Adapter for composite video

S-video

m Audio cable with dual RCA plugs at one end and a stereo miniplug at the
other end, or dual RCA plugs at each end.
RCA
Stereo miniplug

m A cable to connect your TV to your VCR.
You can also use an all-in-one cable (with one video and two audio RCA
plugs at each end) if you attach appropriate adapters.
IMPORTANT A Y-shaped adapter is supplied with the round microphone for

some models of the Macintosh. This adapter is not compatible with your
Macintosh.
2

Attach one end of the video cable to the Video In socket on the VCR (follow the
directions that came with the VCR).

3

Plug the other end of the video cable (or adapter) into the S-video output port on the
Macintosh.

If the connector doesn’t slide easily into the port, realign it and try again.
Forcing a connector into the port could damage the computer or cable.
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4

Plug the RCA connectors on the audio cable into the left and right Audio In sockets on
the VCR.

5

Plug the stereo miniplug on the audio cable (or adapter) into the sound output port on
the Macintosh.

For more information about the sound output port and the stereo miniplug,
see Chapter 7.
6

Connect the VCR’s Video Out port to the television’s Video In port.

Use an RCA or S-video cable to connect the VCR to the television. Do not
use coaxial cable.
To ensure that your presentation is recorded on videotape and shown on the
television, you must connect the VCR to the computer and the television to
the VCR.
7

Connect the microphone to the sound input port (X) on the Macintosh.

The illustration below shows the equipment configuration and the
connections needed to record the computer’s video output and to add voice
annotation to the video.
Microphone
S-video
output port
Sound
output
port

Video
In port

Audio In ports
(left and right)

Video
Out port
TV

Sound
input
port

VCR

3.5 mm miniplug to dual RCA-plug cable
(available at most electronics supply stores)

8

Video In port

Turn on the computer, the VCR, and the television.
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9

Open the Sound control panel and choose Sound In from the pop-up menu.

The Sound control panel is in the Control Panels folder in the Apple (K)
menu.

10

Click the Options button.

The Input Source dialog box appears.
11

Make sure that Microphone is selected, then click the Play-Through box and click OK.

The Microphone icon stands for the device
connected to the sound input port.

When devices are connected to both the sound input and output ports, the
playthrough option sends the incoming sound (from the microphone in this
example) to the device connected to the sound output port (the VCR in this
example).
12

Close the Sound control panel.

You’re almost ready to record. But before you can begin recording, you need
to display the computer’s output on the television. Follow the steps in the next
section,“Using a Television as a Monitor.”

108

Chapter 8

Using a television as a monitor
There are two ways to use a television as a monitor:
m As just described in the previous section, you can connect a VCR to the
computer’s S-video output port, and connect a television to the VCR’s video
output port. Then you can record a presentation on videotape as it is
displayed on the television.
m You can connect a television directly to the computer’s S-video output port
and display the computer’s images on it. This capability is especially useful
if you’re using your Macintosh to give a presentation and you have access
to a large-screen television. If your television does not support S-video,
attach the adapter for composite video as described earlier in this chapter.
(Be sure to use the adapter marked with the Â icon.)
Follow these steps to display the computer’s images on a television.
1

Make sure that the television is connected and turned on.

If you are recording a presentation, the television should be connected to the
VCR’s video output port.
If you are displaying the computer’s images without recording, the television
should be connected to the computer’s S-video output port.
2

Open the Monitors control panel and click the Options button.

The Monitors control panel is located in the Control Panels folder in the
Apple (K) menu.
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3

In the box labeled “Select Monitor Type,” choose one of the resolution types listed.

You can usually use one of these:
m 512 x 384 Resolution for the NTSC standard used in the U.S. and Japan
m 640 x 480 Resolution or lower (Macintosh Hi-Res Display, 640 x 400
Hi-Res, or 640 x 480 Resolution) for the PAL and NTSC standard in most
of Europe and Australia
You need to choose a resolution of 640 x 480 or lower to ensure that the
computer’s entire image is shown on the television and recorded on videotape.

The choices in this list vary according to
the monitor you’re using. If your monitor is
larger than 14 inches, select a resolution of
640 x 480 or smaller to show the entire image
on a television.

4

Click OK.

The Options dialog box closes.
5
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Open the Monitors control panel if it is not already open, and click the Options button.

6

In the Video Display Options section, click the button labeled “Display Video on
Television.”

Choose the type of video signal.
NTSC is standard in the U.S. and
Japan; PAL is standard in most of
Europe and Australia.

Click to eliminate
flicker on the
television screen.

7

Click the options you want, then click OK.

A dialog box appears, asking you to confirm your changes.
8

Click Switch to use the television as the monitor.

The computer’s image is displayed on the television. The regular monitor goes
dark.
Repeat steps 2 through 8 to switch from the television back to the regular
monitor. Choose your regular monitor’s type in step 3 and select “Display
Video on RGB Monitor” in step 6.
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To use the television as the startup monitor, click the Options button on the
Monitors control panel, and check the box shown below.

Click this box if you want to use the television
as the monitor when the computer starts up.

To resume using a regular monitor as your startup monitor, open the Monitors
control panel, click Options, and click “Display Video on RGB Monitor.”
IMPORTANT If you are using a television as your startup monitor, and you wish

to disconnect it, be sure to switch back to your regular monitor and turn the
computer off before disconnecting the television. Otherwise, you may not be
able to see the menu bar when you restart the computer.
Tip: If you can’t see the menu bar, hold down x-Option-P-R while you start
the computer. Continue holding the keys until you hear the start-up tone
twice; then release the keys. A normal desktop will appear. (Restarting in this
manner may affect some of your control panel settings. Check the Memory
and control panel, and, if your computer is on an Ethernet network, check to
see that Ethernet is selected in the Network control panel.)
For more information on problems switching between a television and a
regular monitor, read the file named Power Macintosh Read Me. You’ll find this
file on your computer’s hard disk.
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Troubleshooting
Chapter 9

Solutions to Common Problems

Chapter 10

Reinstalling System Software

Part III contains information on what to do if you
experience problems with your computer.

III
part

Refer to this chapter if you experience
problems using your computer

9

Solutions to Common Problems

When you run into trouble
While you’re using your computer, you may occasionally see a bomb icon, an
error message, or experience a problem such as the pointer “freezing” on the
screen. If you have trouble with your computer, take a moment to read the
information in this section. Check the solutions to common problems listed
later in this section. If your problem is related to a particular procedure, look
for information about the procedure in the Macintosh Reference.
For additional troubleshooting information, read the file named Power
Macintosh Read Me. You’ll find this file on your computer’s hard disk.

Take your time
When you see an error message, you don’t have to take action immediately.
The message stays on the screen until you click the OK button or turn off the
Macintosh.
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To help diagnose and correct the problem, gather as much information about
the situation as you can before starting over:
m Make a note of exactly what you were doing when the problem occurred.
Write down the message on the screen and its ID number (if any). Also list
the programs you were using and the names of any items you know have
been added to the System Folder since the system software was installed.
This information will help a service person diagnose the problem. (It is
helpful to keep a printed copy of of the items in your System Folder. See
the Macintosh Reference for information on printing the contents of a
folder.)
m Check the screen for any clues. Is a menu selected? What programs and
document icons are open? Note anything else that seems relevant.
m If you were typing text and were not able to save it before the problem
occurred, you can write down the parts of the text still visible on the
screen so that some of your work will be easy to replace.
m Ask other Macintosh users about the problem you’re having; they may have
a solution for it.
If you need repair service, consult the service and support information that
came with your computer for instructions on how to contact an Appleauthorized service provider or Apple for assistance.

Start over
Often you can eliminate a problem simply by clearing the computer’s memory
and starting over.
If you can, save any open documents before restarting the Macintosh. If your
system is “frozen” and does not respond to any input, or if you have a “bomb”
message on the screen, saving may not be possible. You can try pressing
x-Option-Esc to quit the program in use when the problem occurred; if this
works, you can then save the documents open in other programs before
restarting.
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To restart your Macintosh, try the following steps:
1

If you can, choose Restart from the Special menu or from the dialog box that’s on
screen.

2

If you can’t choose Restart, hold down the x and Control keys while you press the
Power On key.

This key combination restarts the computer. (Use this key combination only
when choosing Restart from the Special menu does not work.)
3

If nothing happens, look for the reset and interrupt switches on the front of your
Macintosh and press the reset switch (the one marked with a triangle).

Pressing the reset switch is like turning the power switch off and then on
again. You will lose any work you haven’t saved. (The interrupt switch is
intended for use by programmers who have debugging software installed.)
4

If pressing the reset switch does nothing, turn off your computer using the power switch,
wait at least 10 seconds, then turn it on again.

5

If the power switch doesn’t turn off the computer, unplug your Macintosh.

If you suspect that the problem is with a peripheral device, such as a printer
or external hard disk, turn it off for 10 seconds or more, then turn it on again
and restart the Macintosh.
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Solutions to common problems
The computer is turned on but the screen is dark.

The Macintosh or the monitor is not getting power, a program has darkened
the screen, or the monitor controls are not adjusted properly.
m If you use a screen saver program, press a key or move the mouse to turn
off the screen saver.
m Check the monitor’s brightness control and turn it up if necessary.
m Check that the monitor is turned on.
m Check that the power cord is plugged in and firmly connected to the
computer and that the electrical outlet has power. The power light on the
computer’s front panel should be on.
m If you have more than one monitor, and only one is dark, check that it is
set up correctly in the Monitors control panel.
If you are displaying video from your computer on television, it is normal for
your regular monitor to be darkened. See Chapter 8 of this book for more
information.
When you start up, a question mark icon appears in the middle of the screen and the
desktop doesn’t appear.

m Your computer may be having a problem recognizing a SCSI device. Turn
off external SCSI devices and restart.
If the computer starts up after you turn off your SCSI devices, read the
section on SCSI devices in Chapter 5 of this manual for information on
connecting SCSI devices and assigning SCSI ID numbers.
m The system software is not installed on the startup hard disk, the system
software is damaged, or the hard disk is not working properly.
Continue reading this section for more information.
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A disk icon with a blinking question mark appeared when you started your computer.

The blinking question mark indicates that your Macintosh cannot find system
software. You may need to repair a damaged disk, or reinstall system software.

m Start your computer using the Disk Tools floppy disk or the Power Macintosh
CD disc (see “Starting Up from a Built-In CD-ROM Drive” or “Starting Up
from a Floppy Drive” in Chapter 10). Then refer to the Macintosh Reference
for information on testing and repairing disks. If repairing the disk doesn’t
help, follow the instructions in Chapter 10 of this book to reinstall your
system software.
A disk icon with an X appeared and the floppy disk was ejected.

Your Macintosh ejected a floppy disk that is not a startup disk.

m Wait a few seconds. The computer should start up from its internal hard
disk. Make sure you insert floppy disks only after the computer has begun
starting up.
A “sad Macintosh” icon appeared and the computer won’t start up.

Your Macintosh cannot start up because of a problem with the system
software or the computer hardware.

m Eject any floppy disks by turning off the computer and then holding down
the mouse button while you turn the computer on again. Try starting up
with a different startup disk (such as the Disk Tools floppy disk or the Power
Macintosh CD disc). If the “sad Macintosh” icon appears again, consult the
service and support information that came with your computer for
instructions on how to contact an Apple-authorized service provider or
Apple for assistance.
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The hard disk icon does not appear on the desktop.

If you don’t see a hard disk icon on the desktop, try the following:
m If the hard disk is internal, shut down your Macintosh, wait at least 10
seconds, and then turn it on again.
m If the hard disk is external, make sure it is turned on and its cable is
connected firmly; then restart the Macintosh.
m Check the ID numbers of all SCSI equipment connected to your computer.
See the information on SCSI devices in Chapter 5 of this book.
m If the hard disk is your startup disk, start your computer using the Disk
Tools floppy disk or the Power Macintosh CD disc (see “Starting Up from a
Built-In CD-ROM Drive” or “Starting Up from a Floppy Drive” in Chapter
10). Then refer to the Macintosh Reference for information on testing and
repairing disks. If repairing the disk doesn’t help, follow the instructions in
Chapter 10 of this book to reinstall your system software.
Icons do not appear correctly on your screen.

You need to “rebuild the desktop”—a process that helps your Macintosh keep
track of files and folders on your hard disks.
m Hold down the Option and x keys while starting up your computer. Keep
holding down the keys until you see a message asking whether you want to
rebuild the desktop. Click OK.
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Your Macintosh can’t read a floppy disk.

If you see a message that a floppy disk is unreadable, try one of the following:
m If the disk has never been used, you may simply need to initialize it. See
the Macintosh Reference for information.
m The disk might be damaged. See the Macintosh Reference for information
on testing and repairing disks.
If you are trying to use a DOS disk:
m The disk may have been formatted incorrectly on a DOS computer. On
DOS computers it’s possible to format a standard double-sided disk in a
high-density (1440K) format, and vice versa. Disks formatted this way
cannot be read by a Macintosh computer.
When formatting disks on a DOS computer, always format standard
double-sided disks in the 720K format. Always format high-density disks
in the 1440K format.
If a disk has been formatted incorrectly, use a DOS computer to copy its
contents onto another disk that has been properly formatted.
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The pointer doesn’t move when you move the mouse.

The mouse is not connected properly, or its signals are not reaching the
computer, or there is a software error.
m Turn off the computer using the power button, check that the mouse cable
is connected properly, then restart the computer.
m Clean the mouse (see the Macintosh Reference).
m If you have another mouse or pointing device, try connecting and using it.
(Turn off the computer first.) If it works, there is probably something
wrong with your mouse.
m Restart the Macintosh with a different startup disk (such as the Disk Tools
disk or the Power Macintosh CD disc). If the mouse works, reinstall system
software on your startup disk.
m If the problem recurs, it may be due to an incompatible program. Make
sure that all programs, desk accessories, and system extensions you’re using
are compatible with the system software.
If none of these procedures solves the problem, consult the service and
support information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance.
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Typing on the keyboard produces nothing on the screen.

The insertion point hasn’t been set, no text is selected, the keyboard is not
connected properly, the keyboard’s signals are not reaching the computer, or
there is a software error.
m Make sure the program you want to type in is the active program.
m Place the pointer in the active window and click to set an insertion point or
drag to select text (if applicable).
m Turn off the computer using the power button, then check that the keyboard
cable is connected properly at both ends.
m Turn off the Macintosh, then connect the keyboard cable to the other ADB
port (marked with the V icon) on the keyboard. (You may have to unplug
the mouse to do this.) If your keyboard cable is connected to your monitor,
connect it to another ADB port on the monitor or directly to the computer’s
ADB port (on the back of the computer). If typing still doesn’t work, the
problem is most likely in the keyboard itself.
m If you have access to another keyboard, try using it instead. (Turn off the
computer before connecting it.)
m Restart the Macintosh with a different startup disk (such as the Disk Tools
floppy disk or the Power Macintosh CD disc). If this solves the problem,
reinstall system software on your startup disk.
If none of these procedures solves the problem, consult the service and
support information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance.
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A dialog box with a bomb appears.

Your system has a software problem.
m Write down what you were doing when the message appeared, and write
down the number on the message, if there is one.
m Restart your Macintosh (see “Start Over” earlier in this chapter). Most
software problems are temporary and restarting usually corrects the
problem.
m If the problem recurs, check the startup disk and program you are using
when the message appears. Make sure that all programs, desk accessories,
and system extensions you’re using are compatible with the system
software. Reinstalling the system software may correct the problem.
m Sometimes incompatible system extensions or control panels can cause
system software problems. Restart while holding down the Shift key; this
temporarily turns off all system extensions. If your computer works
normally with this method, then remove all extensions from the Extensions
folder (inside the System Folder) and put them back into the Extensions
folder one at a time. Restart after you add each extension. This procedure
should identify any incompatible extensions.
You can’t start your program or it quits unexpectedly.
When you try to open a program, you see a message that not enough memory is
available.

The program needs more memory or the Macintosh ran out of memory.
m Quit the programs that you have open and then open the program you want
to use, or restart your Macintosh.
m Use the program’s Info window to give it more memory. For more
information see the section in the Macintosh Reference on setting up your
programs.
m Use the Memory control panel to turn on virtual memory. This is
especially important if you are using any programs designed for Power
Macintosh. For more information, see Chapter 6 of this book, and read the
information on “Using Hard Disk Space As Memory” in the Macintosh
Reference.
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You see a message that your application program can’t be opened because a
file can’t be found.

Power Macintosh programs use special files called shared libraries. Any
necessary shared libraries should be installed automatically when you install
Power Macintosh programs.
m Follow the directions that came with your program to reinstall the
program. If the shared library is still missing, contact the software
program’s manufacturer for assistance.
You experience problems using an older Macintosh program.

Some older Macintosh programs are not completely compatible with the
Power Macintosh computers.
m Open the Memory control panel and turn off Modern Memory Manager.
For more detailed instructions, see “Using Older Macintosh Programs” in
Chapter 6 of this book.
You experience problems using a document from a DOS computer.

If you can’t open a DOS document using a Macintosh program, try the
following:
m Open the document from within the program by using the Open command
in the program’s File menu.
m Use the PC Exchange control panel to change the document’s type to one
that can be opened by the program. See “Exchanging Files with DOS or
Windows” in the appendix.
If a DOS document is displayed incorrectly, or you see strange codes or
characters in the document:
m Your application program may have special procedures for opening and
saving documents with different file formats. See the information that
came with your application program.
m Try opening the document in another program.
Note: Some characters that can be displayed on the Macintosh are not
accurately displayed on DOS computers.
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You see a message that an application program can’t be found.

The dialog box below appears if you try to open a document created using
software that is not on your hard disk.

Normally, you see this message if you try to open a document that came from
another Macintosh with software that is different from yours.
m Some documents can be opened by more than one application program.
Try starting a program that you think might be able to open the document,
then choose use the Open command from the program’s File menu to try to
open the document. (Or drag the document to the program’s icon. If the
program can open the document, the program’s icon highlights.)
m Purchase and install the correct software to use the document, or find out
if the original owner of the document can convert it to a form that one of
your programs can use.
m Don’t try to open the files in your System Folder. Most of the System
Folder files are used by your computer for internal purposes, and are not
intended to be opened.
m Rebuild your desktop by holding down the Option and x keys while
starting up your computer. Keep holding down the keys until you see a
message asking whether you want to rebuild the desktop. Click OK.
m If the document is from a DOS computer, use the PC Exchange control
panel to specify which Macintosh program will open the document. See
“Exchanging Files with DOS or Windows” in the appendix.
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Read this chapter only if you need
to reinstall system software

10

Reinstalling System Software

System software is the set of programs and other files that your computer uses
to start itself up, keep track of your files, and run the application programs
you use. System software is kept in the folder called the System Folder. When
you turn on your computer, it looks for a startup disk, which is a disk that
contains the system software. The startup disk is usually the hard disk that’s
inside your computer, though another hard disk or a floppy disk can also be
a startup disk.
The accessory kit that came with your Macintosh contains either a set of
floppy disks with the system software on them or a CD-ROM disc labeled
Power Macintosh CD. You can use the floppy disks or the CD-ROM disc to
install the system software on your Macintosh if you need to do so.
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Do you need to install system software?
Your Macintosh came with all the necessary system software installed on your
hard disk. Unless a problem develops later, you don’t need to reinstall the
software.
If you have a problem with your system software, you may see this icon in the
middle of the screen:

If you see this icon, start your computer using the Disk Tools floppy disk or
the Power Macintosh CD disc. Then refer to the Macintosh Reference for
information on testing and repairing disks.
If repairing the disk doesn’t help, follow the instructions in this chapter to
start up your computer and reinstall system software.
IMPORTANT If you’ve used a backup program to make a backup copy of your

system software, you should reinstall your system software from your backup
disks. See the documentation that came with your backup program.

Starting up from a built-in CD-ROM drive
If your computer has a built-in CD-ROM drive you can use the CD-ROM disc
labeled Power Macintosh CD to start your computer.
1

Turn on your computer.

2

Place the Power Macintosh CD disc in the CD-ROM drive’s tray with the label facing up,
and close the tray.

Your Macintosh recognizes the CD as a startup disk, and in a few seconds the
desktop appears. (The disc’s window is open on the desktop.)
IMPORTANT Use the Power Macintosh CD disc as a startup device only when

your startup disk is not working properly, to reinstall or make a copy of your
system software files.
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Starting up from a floppy drive
Unless your computer has a built-in CD-ROM drive, the accessory kit that
came with your computer contains a set of floppy disks. You can use the
Install Me First floppy disk to start your computer:
m Insert the disk into the floppy drive and turn on your computer.
An Installer screen opens automatically to let you reinstall system software
on your hard disk. Follow the instructions in the next section to reinstall
system software.
If you want to start your computer from a floppy disk without installing
system software, use the Disk Tools disk (insert the Disk Tools disk into the
floppy drive and turn on your computer).
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Reinstalling system software
Before you begin, you must start your computer following the instructions in
the previous section under “Starting Up From a Built-In CD-ROM Drive” or
”Starting Up From a Floppy Drive.”
You use the Installer to reinstall system software.
m If you started up from the Power Macintosh CD disc, double-click the icon
named Install System Software.
m If you started up from the Install Me First floppy disk, the Installer opens
automatically.
Follow these steps to install system software:
1
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In the Welcome dialog box that appears, click OK.

2

Check that the disk named in the box is the one on which you want to install system
software.

If not, click the Switch Disk button until the correct disk name appears.

The items in this
illustration may not
exactly match those
on your screen.
This is the disk on
which system
software will be
installed.

3

Click to install on a
different disk.

In the Installer dialog box, click Install.

The Easy Install status box appears and keeps you informed of progress
during installation.
If you are installing from floppy disks, follow the instructions asking you to
insert different disks.
4

If you see a message telling you that you need to restart your system, click Restart.
Otherwise, click Quit.

If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
That’s it. You’ve installed Macintosh system software on your startup disk.

Reinstalling System Software

131

Custom installation
You can use the Installer’s “custom” feature to install specific items from a
list. If you click the Customize button in the Installer dialog box, you’ll see
the list. Hold down the Shift key and click the items you want. Then
click Install.
If you use Easy Install, all the items you need are installed automatically. You
don’t need custom installation.

Reinstalling the CD-ROM software
Your built-in CD-ROM drive requires special software, which is already
installed on your hard disk. If you experience problems using your CD-ROM
drive, try reinstalling the CD-ROM software.
When you reinstall the CD-ROM software, you should also reinstall the
QuickTime software.
Follow these steps:
1

Place the Power Macintosh CD disc in the CD-ROM drive’s tray with the label facing up,
and close the tray.

The Power Macintosh CD disc’s window opens automatically.
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2

Double-click the Install System Software icon to open the Installer.

3

In the Welcome dialog box that appears, click OK.

4

Check that the disk named in the box is the one on which you want to install CD-ROM
software.

If not, click the Switch Disk button until the correct disk name appears.

The items in this
illustration may not
exactly match those
on your screen.
This is the disk on
which CD-ROM
software will be
installed.

5

Click to install on a
different disk.

In the Installer dialog box, click Customize.

You see a list of items you can install.
6

Hold down the Shift key and click to select “CD-ROM System Software” and “QuickTime
Software.”

7

Click Install.

The CD-ROM and QuickTime software are automatically installed and placed
in the System Folder on your hard disk.
8

When you see a message reporting that installation was successful, click Restart.

Your CD-ROM drive will now operate normally. (If a message reports that
installation was not successful, follow the instructions on the screen to try
installing again.)
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Copying system software from the Power Macintosh CD disc
You can copy the Macintosh system software from the Power Macintosh CD
disc to floppy disks. You need to use the Disk Copy program to make a copy
of the system software. (Dragging system software files to floppy disks does
not work because the Installer expects the files to be in certain places on the
floppy disks.)
To copy the software, you’ll need five or more high density (1.4 MB) floppies.
1

Insert the Power Macintosh CD disc into the CD-ROM drive.

2

Open the folder named “Disk Images” and locate the Disk Copy icon.

You may need to scroll the window to see the icon.
3

Double-click the Disk Copy icon to start the program.

4

Click anywhere on the screen to remove the explanatory dialog box.

The Disk Copy window appears.
5

In the window, click Load Image File.

A dialog box appears, in which you can select the disk image that you want to
copy. Each image file contains the software for one system software disk.
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6

Click the name of a disk image, then click Open.

In a few moments a message appears near the top of the window, indicating
that the disk image has been loaded.
7

Click Make A Copy.
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8

When you see a message telling you to insert a disk, insert a floppy disk.

If the disk already contains information, you’re asked whether you want to
replace the contents of the disk. Click Duplicate if you want to erase the
information on the disk and replace it with a copy of system software.
Otherwise, eject the disk and insert a different disk.
9

When you see a message telling you that the disk was duplicated successfully, click
Load Image File to copy another disk image or click Quit to leave the program.

The program ejects the disk when it has copied the image.
10

Repeat steps 6 through 9 for each disk image until you have copied all the disk image
files.

Store the backup disks in a safe place.
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Read this appendix for information
on using the Macintosh PC
Exchange program

Appendix
Exchanging Files With DOS or Windows

Macintosh PC Exchange is software included with your computer that lets
you easily exchange documents between your Macintosh and a DOS or
Windows computer. You can use Macintosh PC Exchange to create floppy
disks compatible with DOS computers.

Macintosh PC Exchange at a glance
You can open, edit, and save DOS documents using
your favorite Macintosh application programs.
Using the PC
Exchange control
panel, you can
specify which
Macintosh programs
are used to open
DOS documents.

You can use and create
DOS-format disks.

For example, DOS
documents whose
names end with
this suffix . . .
. . . are to be opened
by this program . . .
. . . as this type of document.

137

Using DOS-format disks on your Macintosh
The format of a disk refers to the way the computer prepares the disk to
receive information. Macintosh computers and DOS computers use different
disk formats, but with Macintosh PC Exchange installed in your Macintosh
system, your Macintosh can read disks of either format.
To use a DOS-format disk on your Macintosh, simply insert the disk into your
computer’s floppy disk drive. The disk’s icon appears on the desktop. You can
open the disk by double-clicking its icon—the same way you would open an
ordinary Macintosh disk.

When you insert a DOS-format
floppy disk, you see this icon.

If you see a message that the disk is unreadable, see “Solutions to Common
Problems” in Chapter 9 of this book.
WARNING Do not attempt to repair a DOS-format disk using disk repair

programs intended for use on the Macintosh. Doing so is likely to
destroy any information on the disk. If you must repair a DOS-format
floppy disk, use a disk repair utility on your DOS computer.

Creating a blank DOS-format disk
When you erase or initialize a disk on the Macintosh, you can choose its
format—either Macintosh or DOS.
WARNING Before you erase or initialize a disk, be sure that the disk

contains no information you want to save.
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To create a blank DOS-format disk on your Macintosh, follow these steps:
1

Insert a floppy disk.

m If the disk has not been initialized, a dialog box appears in which you can
specify the disk’s name and format.

m If the disk has already been used, you’ll need to erase it. Select the disk,
then choose Erase Disk from the Special menu.

A dialog box appears in which you can specify the disk’s name and format.
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2

Type a name for the disk.

3

Choose the disk format you want from the Format pop-up menu.

The list of available formats varies depending on your disk drive and the
capacity of the disk. Choose DOS if you plan to use the disk on both
Macintosh and DOS computers.

4

Click Erase (or Initialize).

If you’re initializing a disk, an alert box appears. Click the Continue button.
The Macintosh prepares the disk in the format you chose.
Usually it takes less than a minute to initialize or erase a floppy disk.
However, if portions of the disk have been damaged, the initialization process
may take several minutes.
If you changed the disk’s format, the disk’s icon will change when you
reinsert the disk.
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Opening DOS documents on your Macintosh
Opening a document from within a Macintosh program
The surest way to open a DOS document on the Macintosh is to use the Open
command from within an application program.
1

Open the program you want to use.

2

Choose Open from the File menu.

A directory dialog box appears.

Many programs have buttons or pop-up
menus that let you open or import
documents of a particular file format.

3

Select the document you want, and click Open.

If you have problems opening the document, see “Solutions to Common
Problems” in Chapter 9 of this book.
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Opening a document by double-clicking its icon
Before you can open a DOS document by double-clicking its icon, you need
to use the PC Exchange control panel to specify which Macintosh application
programs will open DOS documents, as described next.

Assigning Macintosh programs to DOS documents
Using the PC Exchange control panel, you can assign Macintosh application
programs to DOS documents. For example, you can specify that all DOS
documents whose filenames end with the suffix .XLS are to be opened in the
Macintosh program Microsoft Excel.
The figure below shows the PC Exchange control panel with some
assignments already created.

DOS documents
whose names end
with this suffix…

…as this type
of document.

…are to be opened by this
Macintosh program…
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Before you can assign a Macintosh program to a group of DOS documents,
you need to answer three questions:
m What suffix do the documents have in common?

Many DOS programs automatically add a three-letter suffix (or filename
extension) to a document’s name. For example, these PageMaker documents
all share the suffix .PM4:
NEWS.PM4
REPORT.PM4
RESUME.PM4
m What Macintosh application program do you want to use to open the documents?

Each Macintosh document has a creator—that is, the Macintosh program
used to create the document. When you double-click a document’s icon,
the Macintosh opens the program that created the document.
Using the PC Exchange control panel, you can assign Macintosh programs
to DOS documents as “creators.”
m What type of document is it?

Most programs are able to open or import some, but not all, types of
documents. A document’s type is a three- or four-letter code (such as
TEXT or PICT) that tells a program whether or not it can recognize the
document. A program displays documents of types it can recognize in its
directory dialog box.
Unless you specify otherwise, the Macintosh assumes that all DOS
documents have the document type TEXT. You can assign different types
to some DOS documents. See the next section.
A document’s type is different from its file format, which refers to the way
information within the document is encoded. If a program is unable to
accurately interpret a document’s file format, the document’s formatting may
be displayed incorrectly. (To find out which file formats a program can
understand, refer to the documentation for the program.)
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Recommended assignments for some widely used application
programs
The information in this section will help you assign documents from some
widely used DOS/Windows programs to some widely used Macintosh
programs. (For more information, see the documentation for your application
programs.)
AMI Pro (Windows), version 2.0
Documents in AMI Pro (Windows) version 2.0 are automatically saved with
the suffix .SAM.
To open these documents on the Macintosh, add one of the following
assignments to the PC Exchange control panel:
DOS suffix

Macintosh application

Document type

.SAM

MacWrite® II (version 1.1)

TEXT

.SAM

Microsoft Word (version 5.0)

TEXT

.SAM

WordPerfect (version 2.0)

TEXT

.SAM

WriteNow (version 2.2)

TEXT

Lotus 1-2-3 (Windows), version 1.0
Documents in Lotus 1-2-3 (Windows) version 1.0 are automatically saved with
the suffix .WK3.
To open these Lotus 1-2-3 documents on the Macintosh, add one of the
following assignments to the PC Exchange control panel:
DOS suffix
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Macintosh application

Document type

.WK3

Lotus 1-2-3 (version 1.0)

TEXT

.WK3

Microsoft Excel (version 3.0)

TEXT

Microsoft Excel (Windows), version 3.0
Documents in Microsoft Excel (Windows) version 3.0 are automatically saved
with the suffix .XLS.
To open these Microsoft Excel documents on the Macintosh, add one of the
following assignments to the PC Exchange control panel:
DOS suffix

Macintosh application

Document type

.XLS

Lotus 1-2-3 (version 1.0)

TEXT

.XLS

Microsoft Excel (version 3.0)

TEXT

Microsoft Word (Windows), version 2.0
Documents in Microsoft Word (Windows) version 2.0 are automatically saved
with the suffix .DOC.
To open these documents in Microsoft Word (Macintosh) version 5.0, add the
following assignment to the PC Exchange control panel:
DOS suffix
.DOC

Macintosh application

Document type

Microsoft Word (version 5.0)

WDBN

PageMaker (Windows), version 4.0
Documents in PageMaker (Windows) version 4.0 are automatically saved with
the suffix .PM4.
To open these documents in PageMaker (Macintosh) version 4.0, add the
following assignment to the PC Exchange control panel:
DOS suffix
.PM4

Macintosh application
PageMaker (version 4.0)

Document type
ALB4
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Quattro (DOS), version 3.0
When saving documents in Quattro (DOS) version 3.0, be sure to save them
with the suffix .WK1 (rather than the default suffix, .WQ1). Quattro saves
documents ending in .WK1 in the Lotus 1-2-3 file format, which can be
interpreted by many Macintosh spreadsheet programs.
To open these Quattro documents on the Macintosh, add one of the following
assignments to the PC Exchange control panel:
DOS suffix

Macintosh application

Document type

.WK1

Claris Resolve™ (version 3.0)

TEXT

.WK1

Lotus 1-2-3 (version 1.0)

TEXT

.WK1

Microsoft Excel (version 3.0)

TEXT

Ventura Publisher (Windows), version 3.2
Documents in Ventura Publisher (Windows) version 3.2 are automatically
saved with the suffix .CHP.
To open these documents in Ventura Publisher (Macintosh) version 3.2, add
the following assignment to the PC Exchange control panel:
DOS suffix
.CHP

Macintosh application
Ventura Publisher (version 3.2)

Document type
VCHP

WordPerfect (DOS), version 5.1
WordPerfect (DOS) version 5.1 does not automatically add a suffix to the
names of documents. The easiest way to open WordPerfect (DOS) documents
on the Macintosh is by choosing the Open command from within an
application program.
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Adding an assignment to the PC Exchange control panel
To add an assignment, follow these steps:
1

Choose Control Panels from the Apple (K) menu.

The Control Panels folder opens.
2

Open the PC Exchange control panel.

Double-click the PC Exchange icon, or select the icon and choose Open from
the File menu.

The PC Exchange control panel appears.
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3

Click the Add button.

A dialog box appears in which you can specify a DOS suffix and its
corresponding Macintosh application program and document type.

4

Type a three-letter DOS suffix in the DOS Suffix box.

To specify which Macintosh program will open DOS documents with no
suffix, click inside the box to set the insertion point, but leave it blank.
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5

Choose a Macintosh application program from the lower section of the dialog box.

6

Choose a document type from the Document Type pop-up menu.

Document types are indicated by icons and four-letter codes whose meanings
are seldom obvious. For help choosing the correct document type, see the
information in the previous section, “Recommended Assignments for Some
Widely Used Application Programs.”
If you don’t know which document type to choose, try TEXT.
7

Once you’ve specified a DOS suffix, a Macintosh application program, and the
appropriate document type, click OK.

The assignment is added to the list in the control panel.
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Trying out an assignment
To try out an assignment you’ve added to the PC Exchange control panel,
follow these steps:
1

Insert a DOS-format floppy disk and open its icon.

PC Exchange assignments take effect when you insert a floppy disk, or when
you open a DOS-format floppy disk. (If the disk window was already open,
you need to close it and open it again.)
2

Double-click the icon of a DOS document whose filename ends with the suffix you
specified.

The document is opened by the appropriate Macintosh application program.
(You might see a message that the document’s file format is being converted.)
If you have problems opening documents, see “Solutions to Common
Problems” in Chapter 9 of this book.

Editing the list of assignments
You can change, remove, and sort assignments in the PC Exchange control
panel.

To sort the list of
assignments, click
a category.

To remove an assignment, select
it in the list, then click Remove.
To change an assignment, select
it in the list, then click Change.
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Sharing assignment lists with other users
The list of assignments is stored in the PC Exchange Preferences file. This
file is stored in the Preferences folder inside the System Folder.

You can make sure that every user of Macintosh PC Exchange in your office
uses the same assignments. Make copies of the PC Exchange Preferences file
and place one copy in the Preferences folder (inside the System Folder) of
each user’s Macintosh.
Do not change the name of the PC Exchange Preferences file.

Saving documents onto a DOS-format disk
You save documents onto a DOS-format disk the same way you save them
onto a Macintosh disk—by choosing the Save command from the File menu.
IMPORTANT Be sure to leave at least 5K of extra disk space when you save or

copy files onto a DOS-format floppy disk. (The Macintosh needs this space to
store Macintosh-specific information about files on the disk, such as the
location of icons and windows on the Macintosh desktop.)
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Choosing a file format
In some programs you’ll have the choice of saving the document in one of
several file formats.

The Save As dialog
box may include
buttons or pop-up
menus for choosing
a file format.

A document’s file format refers to the way information within the document is
encoded. If a program cannot accurately interpret a document’s file format, it
may display the document incorrectly (as in the figure below).

When you save a document that you plan to use with another program, be
sure to save it in a file format that the other program can understand. (To find
out what file formats a program is able to open, import, and save, see the
documentation you received with the program.)

Naming files for use on both Macintosh and DOS computers
On DOS computers, filenames are limited to eight characters (plus a threeletter suffix) and may not contain spaces. The rules for naming Macintosh
files are less restrictive. Therefore, when working on the Macintosh, it’s
possible to give a file a name that would be illegal on DOS computers.
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For example, suppose you created a file on your Macintosh named
July Budget.DOC
If you viewed the same file on a DOS computer, its name would be
!JULYBUD.DOC
The exclamation mark (!) indicates that the name has been shortened.
A file can thus have two names: a long name (for when the file is displayed
on the Macintosh) and a short name (for when it’s displayed on a DOS
computer).
While using a DOS-format floppy disk on the Macintosh, you can see a
document’s short name by selecting the document, choosing the Get Info
command from the File menu, and clicking the document’s name in the Info
dialog box. (For this procedure to work, you must have the File Sharing
Extension installed.)
Long name

Short name

Viewing the contents of a disk on your DOS computer
When you view the directory of a disk on your DOS computer, you might
notice additional directories named RESOURCE.FRK. These directories
contain important information, known as resources, which are contained in
some Macintosh documents.
WARNING Do not delete or move any directories named

RESOURCE.FRK, and do not move any files out of these directories.
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Index

A
active window 43, 49
adapters. See also connectors; RCA plugs
Apple Ethernet Media Adapter 80
for composite video connectors
98–99, 100, 105–106
for expansion card (NuBus) 59
GeoPort Telecom Adapter 80
Y-shaped 100, 106
ADB port 8, 70, 71, 78
ALB4 document type 145
alert sounds, recording 92
all-in-one cables 100, 106
AMI Pro (Windows) version 2.0
documents, assigning to
Macintosh programs 144,
147–151
amplifier, connecting 89
Apple-authorized dealers
adding internal equipment 68
Apple Ethernet Media Adapters 80
Apple QuickTime Starter Kit 105
communications and fax software 80
microphones 79, 89
obtaining devices and supplies vii

Apple-authorized service providers
expanding memory 68
how to contact vii, 16, 116, 119,
122, 123
installing an expansion card 61
removing factory-installed cards 59
removing terminators 76
servicing laser equipment viii
AppleCD Audio Player program 94
Apple Desktop Bus. See ADB
Apple Ethernet Media Adapter 80
Apple Extras folder 86, 102
Apple PlainTalk Microphone 79, 89, 106
Apple QuickTime Starter Kit 105
AppleTalk Phase 2 protocol support 80
Application menu icon 55
application programs. See programs
arrow keys 56
arrow pointer, moving 24–27
assigning documents from DOS/windows
programs to Macintosh
programs 142–151
assignments, adding to the PC Exchange
control panel 147–149
audio cable 100–101, 106–107
audio CDs, playing 88, 93, 94
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audio connector. See stereo miniplug
audio devices, connecting to the
Macintosh 89–92
Audio In port
on speakers 93
on VCR 107
audio input/output options, choosing
90–92
Audio Out ports on VCR 101
AudioVision monitors 4, 6, 7
AV Connector Input Source option
90–91, 108
AV system, illustration 96

B
bar-code reader, connecting 78
blinking question mark 11, 118–119, 128
“bomb” icons or messages 115, 116, 124
brightness control 12, 69, 118

C
cables
all-in-one 100, 106
audio 100–101, 106–107
composite video device 98–99
external speaker 93
illustration 1
monitor 6–7
SCSI peripheral interface 75
SCSI system 75
video 100–101, 106–107
camera port 71
capturing a frame of a video image 104
card. See expansion card
carpal tunnel syndrome 18
CD Remote program 94
CD-ROM drive 69, 88, 94
CD-ROM software, reinstalling 132–133
CDs, playing 88, 93, 94
chair, adjusting for computer use 19, 20
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Index

Chooser program 77
.CHP documents (Ventura Publisher)
146
Clipboard 104
Close (File menu) 50
closing
documents 50
programs 37
windows 48
Command (x) key 56
communications software, purchasing 80
components of your computer,
illustration 1
composite video
choosing for input 103
connecting cables 98–99, 105–106
overview 97
computer images, displaying on a
television 109–112
connecting equipment to the Macintosh.
See also installing
amplifier 89
audio devices 89–92
bar code reader 78
composite video devices 98–99
external speakers 89, 93
GeoPort Telecom Adapter 80
graphics tablet 78
microphone 79, 89, 106, 107
modem 80
monitor cable 6–7
monitors 4–7, 78
mouse and keyboard 8
printer 9, 77
scanner 9
SCSI devices 72–76
S-video devices 98
tape recorder 89
television 105–107, 109
trackball or other input device 78
VCR 89, 99, 100–101, 105–107

connectors. See also adapters; RCA plugs
composite video 99, 100–101,
105–106
Digital Audio and Video (DAV) 60
expansion slot connector 59, 65–66
stereo miniplug connector 88, 89
S-video connector 98, 100, 105–106
control panels
Memory 85, 124, 125
Monitors 104, 109–112
PC Exchange 142–150
Sound 90–92, 93, 94, 108
Control panels folder 108, 109
Copy (Edit menu) 104
copying
disk images 134–136
floppy disks 53
a frame of a video image 104
icons 47
system software from the Power
Macintosh CD to floppy disks
134–136
to and from the hard disk 53
copyright laws, prerecorded materials
and 104
cover of computer
removing 61–62
replacing 67
cover plate, removing 64
creating
documents 34–35
folders 38, 54
cumulative trauma disorders (CTDs) 17
custom installation 132

D
Delete key 35
deselecting icons 46
desk accessories 124
desktop
organizing 54
rebuilding 120, 126
device drivers, installing 73
dialog boxes
appearing with a “bomb” 124
disk duplicator 134–136
Easy Install 131, 132
Input Source 90–91, 108
keyboard shortcuts in directory dialog
boxes 56
Options (Monitors control panel)
110–112
Digital Audio and Video (DAV)
connector 60
disconnecting power to the computer 3
Disk Copy program 134–136
disk duplicator dialog box 134–136
disk images, copying 134–136
Disk Images folder 134
disks. See also floppy disks; hard disks
opening higher-level 49
disk space, video images and 105
Disk Tools disk 119, 122, 123
displaying
computer images on a television
109–112
contents of windows 48–49
video images on the computer screen
99, 102–104
.DOC documents (Microsoft Word) 145

Index
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documents
creating 34–35
naming 35–36, 51
opening 50
problems opening 126
renaming 51
saving 35–36
on a DOS-formatted disk 151–153
working with 50–51
document types 143, 144–146, 149
DOS disks
formatting 121, 138–140
saving documents on 151–153
using on a Macintosh 138–142,
151–153
DOS documents
assigning Macintosh programs to
142–151
opening from a Macintosh program
141–142
problems with 125, 126
types 143, 144–146, 149
DOS filename conventions 152–153.
See also suffixes
DOS/Windows programs, assigning
documents to Macintosh
programs 142–151
double-clicking 25
Duplicate (File menu) 47

E
Easy Install dialog box 131, 132
Edit menu, Copy 104
ejecting floppy disks 52, 119
Empty Trash (Special menu) 41, 48
Enter key. See Return key
Erase Disk (Special menu) 53, 139–140
erasing
floppy disks 53, 139–140
items from a disk 48
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Index

error messages, general suggestions for
resolving 115–117
Ethernet networks, connecting to 80–81
Ethernet port 70, 71, 81
EtherTalk Phase 2 support 80
expansion card
for connecting to a Token Ring
network 81
installing 3, 59–67
expansion card clip
removing 64
replacing 66
expansion slots 59, 60, 65, 66
extensions, DOS filename. See suffixes
Extensions folder 124
external devices for sound input/output
90, 91
external speakers 89, 93
external terminators for SCSI devices 76
eye fatigue related to computer use 17,
18, 20

F
fatigue from computer use, avoiding 20
file formats 143, 152
File menu
Close 50
Duplicate 47
New Folder 38, 54
Open 47, 50
Put Away 48
Quit 37
Save 35–36, 51
Save As 51
filenames. See also suffixes
DOS vs. Macintosh 152–153
files, storing in folders 39
Finder
getting back to 42
keyboard shortcuts in 56

flickering on television screen,
eliminating 111
floppy disk drive, illustration 69
floppy disks
copying 53
copying system software onto
134–136
DOS-format 138–140
erasing 53, 139–140
inserting and ejecting 52, 119
unreadable 121
folders
Apple Extras 86, 102
Control Panels 108, 109
creating 38, 54
Disk Images 134
Extensions 124
opening 39
opening higher-level 49
placing icons in 39, 54
Preferences 151
saving documents in 51
storing files in 39
System Folder 84, 126, 127
formatting a disk in DOS format 121,
138–140
frame, capturing a video image
frame 104
furniture, arranging 19–20

G
GeoPort 70, 71, 80
GeoPort Telecom Adapter, connecting
80
graphics tablet, connecting 78
grounding plug 2
Guide to Apple Extras 86, 102

H
hard disks
copying items to and from 53
using hard disk space as memory 83
health-related information about
computer use 17–20
Help menu icon 55
high-density monitor port 7, 70, 71
high-speed network, connecting to 80

I, J
icons
ADB 8, 78
blinking question mark 11, 118–119,
128
“bomb” 115
copying 47
deselecting 46
Ethernet 81
hard disk 11, 25, 46
Help menu 55
modem and GeoPort 80
naming 47
opening 47
placing in folders 39, 54
printer port 77
renaming 47
“sad Macintosh” 119
SCSI 72
Trash 40, 46
Video Monitor 102
“X” 119
ID number. See SCSI ID number
initializing a disk in DOS format
138–140
Input Source dialog box 90–91, 108
inserting floppy disks 52, 119
Installer program 130–133
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installing. See also connecting equipment
to the Macintosh; reinstalling
setting up the computer 1–11
device drivers 73
expansion card 3, 59–67
other internal devices 68
PC Exchange program 121
Install Me First disk 129
Internal CD Input Source option 90, 108
internal speaker, playing audio CD
through 94
Interrupt switch 69

K
keyboard
connecting 8
proper positioning of 19, 20
problems with 123
keyboard cable 8
keyboard shortcuts 56

L
long name of a file 153
Lotus 1-2-3 (Windows) version 1.0
documents, assigning to
Macintosh programs 144,
147–151
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M
Macintosh applications, assigning
DOS/Windows documents to
144–151
Macintosh Basics
practicing what you learned 34–37
reviewing (questions and answers)
28–33
taking the tour 23–27
Macintosh PC Exchange. See PC
Exchange program
memory
allocating to video images 104, 105
expanding 68
requirements for Power Macintosh
applications 83
troubleshooting 124
video RAM 104
virtual memory 83, 84, 124
Memory control panel
Memory Manager setting 85, 125
virtual memory and 124
menu bar, can’t see after using a
television as a monitor 112
menus, choosing items from 55
microphone, connecting 79, 89, 106, 107
Microphone Input Source option
90–91, 108
Microsoft Excel (Windows) version 3.0
documents, assigning to
Macintosh programs 145,
147–151
Microsoft Word (Windows) version 2.0
documents, assigning to
Macintosh programs 145,
147–151
miniplug. See stereo miniplug
modem, connecting 80
modem port 70, 71
connecting a printer to 77
Modern Memory Manager (Memory
control panel) 85

monitor cable, connecting 6–7
Monitor menu, Video Settings 103
monitor ports 6–7, 70, 71
monitor power socket 70, 71
monitors
adjusting brightness 12, 69, 118
AudioVision 4, 7
connecting 4–7, 78
proper positioning of 4, 19, 20
troubleshooting 118
turning on 9
using a television as a monitor
109–112
Monitors control panel 104, 109–112
mouse
connecting 8
how to use 24–27
troubleshooting 122
mouse button, pressing 25
musculoskeletal discomfort related to
computer use 17–18, 20

N
naming
documents 35–36, 51
icons 47
networks, connecting to 80–81
New Folder (File menu) 38, 54
NTSC standards
resolution for television display 110
video signal format 103, 111
NuBus adapter 59
NuBus expansion card, installing 59–67
NuBus power requirements 61

O
office furniture, optimal arrangement of
19–20
Open (File menu) 47, 50
opening
documents 50
DOS documents from Macintosh
programs 141–142
folders 39
higher-level folders or disks 49
icons 47
Options dialog box (Monitors control
panel) 110–112

P
PageMaker (Windows) version 4.0
documents, assigning to
Macintosh programs 145,
147–151
PAL standards
resolution 110
video signal 111
PC Exchange control panel 142–150
PC Exchange preferences file 151
PC Exchange program
overview 137
troubleshooting 121, 125, 126
using 142–151
performance, sample rate for sound
output and 92
PICT file, saving a video frame as 104
playthrough sound option 90–91, 92,
94, 108
plugging in the computer 2–3
.PM4 documents (PageMaker) 145
pointer, problems with 122
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ports
ADB 8, 70, 71, 78
Audio In
on speakers 93
on VCR 107
Audio Out ports on VCR 101
camera 71
Ethernet 70, 71, 81
GeoPort 70, 71, 80
high-density monitor 7, 70, 71
modem 70, 71, 77
monitor 6–7, 70, 71
printer 70, 71, 77
SCSI 70, 71, 72
second monitor 6
security lock 70, 71, 82
sound input
connecting a microphone 79, 107
connecting a VCR 101
connecting external devices 90
illustration 70–71
stereo miniplug and 88
sound output
connecting external devices 91
connecting speakers 93
illustration 70–71
stereo miniplug and 88, 107
S-video input
connecting a cable with RCA
plugs 99
connecting a VCR 101
illustration 71, 97
S-video output
connecting a cable with RCA
plugs 99
connecting a television 109
illustration 71, 97
Video In port
on television 107
on VCR 99, 106, 109
Video Out port on VCR 99, 101, 106
positioning the monitor 4, 19, 20
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Index

power cord
computer 2–3
monitor 4–5, 6
Power Macintosh CD
copying system software onto floppy
disks 134–136
installing PC Exchange 121
reinstalling system software 127, 132
starting the computer from 119, 122,
123, 128
Power On key 10, 44. See also
power switch
Power on light 69
PowerPC microprocessor, overview ix
power socket 70, 71
power supply case, discharging static
electricity 63
power switch. See also Power On key
on computer 3, 44, 70, 71
on monitor 9, 12
practicing skills learned in Macintosh
Basics tour 34–37
Preferences folder 151
prerecorded materials, copyright laws
and 104
printer, connecting 9, 77
printer port 70, 71, 77
problems. See troubleshooting
programs
AppleCD Audio Player 94
assigning documents from
DOS/windows programs to
Macintosh programs 142–151
can’t open because a file can’t be
found 125
CD Remote 94
Chooser 77
closing 37
designed for Power Macintosh
computers 83–84
Disk Copy 134–136
Installer 130–133

Macintosh Basics 23–27
opening a DOS file from 141–142
PC Exchange 121, 125, 126, 137,
142–151
QuickTime 132–133
for recording, playing, and editing
video segments 105
shared libraries and 84
SimpleText 34–37
supplied with the Power Macintosh
86
using older Macintosh programs 85,
125
video and animation 105
Video Monitor 102, 104
pull-down menus, choosing items
from 55
Put Away (File menu) 48

Q
Quattro (DOS) version 3.0 documents,
assigning to Macintosh
programs 146, 147–151
question mark on screen. See blinking
question mark
questions and answers from Macintosh
Basics tour 28–33
QuickTime software, reinstalling
132–133
Quit (File menu) 37

R
random-access memory (RAM). See
memory
Rate pop-up menu for sound output 92
RCA plugs 98–101, 105–107. See also
adapters; connectors
rebuilding the desktop 120, 126

recording
alert sounds 92
computer images on a VCR 99
computer output with voice annotation
105–108
video movies 105
Reduced Instruction Set (RISC)
technology ix
reinstalling. See also installing
CD-ROM software 132–133
QuickTime software 132–133
system software 124, 128, 130–132
renaming
documents 51
icons 47
repair service. See Apple-authorized
service providers
repetitive stress injuries (RSIs) 17–18
Reset switch 69, 117
resizing a window 48
resolution for television display 110
RESOURCE.FRK directories 153
resources in Macintosh documents 153
restarting the computer 43, 116–117
Restart (Special menu) 43, 117
retrieving an item from the Trash 41, 48
Return key 56
review of Macintosh Basics tour 28–33

S
safety precautions viii, 15, 16, 44
.SAM documents (AMI Pro) 144
sample rate for sound output 91, 92
Save As (File menu) 51
Save (File menu) 35–36, 51
saving
before restarting the Macintosh 116
documents 35–36, 51
on a DOS-formatted disk 151–153
video frames as PICT files 104
scanner, connecting 9
screen, problems with 118
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screen saver program 118
scroll arrows 48
scroll box 48
SCSI cables 75
SCSI devices
connecting 72–76
troubleshooting 118, 119
turning on the computer and 76
SCSI ID number, setting 73–74
SCSI port 70, 71, 72
SCSI terminators 76
second monitor port 6
security lock, attaching 82
security lock port 70, 71, 82
selecting
icons 43, 46
menu items 55
text 43
setting up
the computer 1–11
SCSI devices 72–76
shared libraries 84, 125
short name of a file 153
Shut Down (Special menu) 44
SimpleText program 34–37
Single Inline Memory Modules
(SIMMs) 68
size box 48
Small Computer System Interface.
See SCSI
software. See programs
solutions to problems. See
troubleshooting
sound
combining with video 105–108
recording alert sounds 92
Sound control panel 90–92, 93, 94, 108
sound input port
connecting a microphone 79, 107
connecting a VCR 101
connecting external devices 90
illustration 70–71
stereo miniplug and 88
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sound output, sample rate for 91, 92
sound output port
connecting external devices 91
connecting speakers 93
illustration 70–71
stereo miniplug and 88, 107
speakers
external 89, 93
internal 94
Special menu
Empty Trash 41, 48
Erase Disk 53, 139–140
Restart 43, 117
Shut Down 44
spoken commands 79, 89, 91
standard monitors 4, 6, 7
“standby” state when computer is off 3
starting the computer
from the Install Me First floppy
disk 129
from the Power Macintosh CD 128
startup disk 124, 127
startup monitor, using a television as 112
static electricity, discharging 63
stereo equipment, connecting. See
connecting equipment to the
Macintosh
stereo miniplug 88, 89, 93, 100–101,
106–107
stereo sound, playing and recording
88–94
suffixes, added to DOS document names
143, 148–150
S-video connector 98, 100, 105–106
S-video format 97
S-video input port
connecting a cable with RCA plugs
99
connecting a VCR 101
illustration 71, 97

S-video output port
connecting a cable with RCA
plugs 99
connecting a television 109
illustration 71, 97
system extensions 124
System Folder 84, 126, 127
system software
copying to floppy disks 134–136
overview 127
reinstalling 124, 128, 130–132
reinstalling CD-ROM software
132–133
troubleshooting 11, 118–119, 124

T
Tab key 56
tape recorder, connecting 89
TCP/IP support 80
telecommunications port. See GeoPort
television
connecting 105–107, 109
eliminating flicker on screen 111
using as a monitor 109–112
using as the startup monitor 112
terminators, SCSI chains and 76
TEXT document type 144, 145, 146, 149
throwing an item away. See Trash
Token Ring network, connecting to 81
trackball, connecting 78
Trash
how to use 40–41
retrieving an item from 41, 48
troubleshooting. See also reinstalling
application program can’t be
found 126
“bomb” icons or messages 115, 116,
124
can’t open documents 125, 126
can’t see menu bar after using a
television as a monitor 112
clues on your screen 42–43, 116

DOS disks or documents 121, 125,
126
file can’t be found 125, 126
floppy disk is ejected 119
floppy disk is unreadable 121
general suggestions 115–117
hard disk problems 120
hardware problems 118, 119–120
icons don’t appear correctly 120
keyboard problems 123
memory allocation to video
images 104
mouse problems 122
not enough memory 124
not enough memory to copy a
frame 104
PC Exchange program 121, 125
pointer freezes 122
program quits unexpectedly 124
rebuilding the desktop 120, 126
repairing DOS-format disks 138
screen is dark 118
SCSI device problems 118, 119
shared library missing 125
system software problems 11,
118–119, 124
turning on the computer 12
typing doesn’t work 123
using older Macintosh programs 125
video image missing 102–103
turning off the computer 3, 43–44
turning on the computer 9–10, 12, 44,
76. See also starting the
computer
tutorial. See Macintosh Basics

U
utility programs. See programs
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V
VCHP document type 146
VCR
connecting to a television and to the
Macintosh 105–107
connecting to the Macintosh 89, 99,
100–101
Ventura Publisher (Windows) version 3.2
documents, assigning to
Macintosh programs 146,
147–151
video cables 100–101, 106–107
videocassette recorder. See VCR
video equipment, connecting 89, 99,
100–101, 105–107
video formats 97–99, 103, 105–106
video frame, saving as a PICT file 104
video images
capturing a frame 104
combining with sound 105–108
displaying on a television 109–112
displaying on the computer screen 99,
102–104
memory allocation and 104
Video In port
on television 107
on VCR 99, 106
Video Monitor program 102, 104
video movies, recording 105
video output port on VCR 99, 109
Video RAM (VRAM) 68, 104
Video Settings (Monitor menu) 103
video system, illustration 96
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viewing
computer images on a television
109–112
contents of windows 48, 49
video images on the computer screen
99, 102–104
virtual memory 83, 84, 124
voice annotation, adding to recorded
computer output 105–108
volume control of external speakers 93

W
WDBN document type 145
windows, working with 43, 48–49
.WK1 documents (Quattro) 146
.WK3 documents (Lotus 1-2-3) 144
WordPerfect (DOS) version 5.1
documents, opening on the
Macintosh 146

X
.XLS documents 145

Y
Y-shaped adapters 100, 106

Z
zoom box 48
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